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1 About This Document 

Welcome to Cube! 

 

The Discover Cube Tutorial will introduce you to the features and capabilities of Cube. This 

document includes information and exercises that can help you understand how Cube works, what 

Cube can do, and how you might start using Cube for analyzing your transportation systems. 

 

The user should note that the Cubetown demonstration model introduces several 

parameters, adjustment coefficients, factors, etc., that are not to be considered as standard 

practice or extended to other models. The Cubetown demonstration model is based on 

fictitious data and variables, and it is intended for learning purposes. 

 

This document contains the following chapters: 

• Chapter 2, “Introduction to Cube” — Introduces you to Cube and to the features and 

architecture of the Cube software suite. 

• Chapter 3, “Getting Started” — Lists components to install in order to do the exercises. 

• Chapter 4, “Exploring Cube Base and Cube Voyager” — Guides you through exercises that 

demonstrate how you can use Cube Base and Cube Voyager when developing data, 

running scenarios, and examining and analyzing outputs. 

• Chapter 5, “Exploring Reports” — Guides you through a series of exercises that 

demonstrate how you can use Cube 6 to simplify the analysis and presentation of results 

from travel forecasting models. 

• Chapter 6, “Exploring Cube Cargo” — Guides you through a series of exercises that 

demonstrate how you can use Cube to analyze freight traffic. 

• Chapter 7, “Exploring Cube Land” — Guides you through a series of exercises that 

demonstrate how you can use Cube to undertake analysis using an integrated Land Use 

Transport Interaction model. 

• Chapter 8, “Discover Activity-Based Modeling Using Cube Voyager” — Guides you through 

the methodology of the ABM model implemented in Cube and some exercises. 

• Chapter 9, “Learning More” — Discusses the additional resources available for learning 

more about Cube. 

• Chapter 10, “Acquiring Cube” — Provides more information on how you can acquire a 

customized Cube software suite. 
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2 Introduction to Cube 

This chapter introduces you to Cube and to the features and architecture of the Cube software suite. 

Topics include: 

 

• The Cube software suite 

 

• Architecture 

 

• Working environment 

 

• Integration with ArcGIS 

 

• Integration of the Cube modules 
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2.1 The Cube Software Suite 

The Cube software suite is a comprehensive set of modules that support transportation planning. 

With Cube, you can generate decision-making information quickly using powerful modeling and GIS 

techniques, statistics and comparisons, high-quality graphical output, and a variety of reporting 

methods. 

 

To help you complete transportation planning and engineering tasks, Cube offers: 

 

• Two unique working modes: 

o Developer mode — Allows you to design and develop transportation models 

o Applier mode — Allows you to quickly and easily apply models for building, testing, 

and evaluating scenarios 

 

• A set of modules and extensions that work within the integrated Cube software environment, 

using common data sources. The modules support: 

o Passenger forecasting, Public Transport modelling and macroscopic traffic 

assignment (Cube Voyager) 

o Freight forecasting (Cube Cargo) 

o Land Use forecasting (Cube Land) 

o Traffic microsimulation (Cube Dynasim) 

o Trip matrix estimation (Cube Analyst suite) 

The extensions support: 

o Dynamic traffic assignment and mesoscopic simulation (Cube Avenue) 

o Running models across multiple processors (Cube Cluster) 

 

• An intuitive model and application workspace that allows you to easily manipulate data 

 

• Direct access to and from ArcGIS, the industry standard for geographic data 

 

• Tools for developing and sharing high quality 2D and 3D animations 
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2.2 Architecture 

Cube is a modular system. You can supplement the core module, Cube Base, with other modules 

that support specific planning techniques. Several modules offer extensions, which enhance a 

module’s feature set. You only need to acquire the modules and extensions required for your tasks. 

 

 
Figure 1 Cube Architecture 

This section introduces each of the Cube modules used in the Cubetown demonstration model (note 

that Cube Dynasim is not included in this demo): 

 

• Cube Base 

• Cube Cluster 

• Cube Voyager 

• Cube Avenue 

• Cube Cargo 

• Cube Analyst (including Analyst and Analyst Drive) 

• Cube Land 
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Cube Base 
Cube Base is the core module of the Cube software suite. Cube Base provides the user interface 

that supports all Cube modules. Cube Base offers tools for: 

• Developing, editing, manipulating, mapping, and graphing data using geographic 

information system (GIS) techniques 

• Designing and applying the modeling and microsimulation process 

• Creating, managing, comparing, and analyzing scenarios 

• Creating high-quality reports and charts from single or multiple scenarios 

 

Integrated with ESRI’s ArcGIS, Cube Base offers advanced GIS functions. 

 

You can use Cube Base to update and apply models developed in Cube Voyager and in Citilabs’ 

other travel forecasting systems: TP+, TRIPS, and Tranplan. 

 

An optional extension is available for Cube Base: 

• Cube Cluster — Adds functions that enable model processes to run across multiple 

computer processors, either within one or on multiple personal computers or servers. 

 

Cube Voyager 
Cube Voyager combines Citilabs’ latest technologies to forecast personal travel. Cube Voyager uses 

a modular, script-based structure. This structure allows you to incorporate any modeling 

methodology in your forecast, such as standard four-step models, discrete-choice models, and 

activity-based models. 

 

With Cube Voyager’s open and user-friendly framework, you can model a wide variety of planning 

policies and improvements at the urban, regional, or long-distance levels. You can create a 

comprehensive library of planning functions under the general Cube framework, and use that library 

to model various policies and improvements. With a well-defined library, you can easily manage data 

and code complex methodologies with a simple step-by-step approach. 

 

Advanced methodologies allow you to model junction-based capacity restraints for highway analysis, 

and discrete-choice path building for multi-route transit assignment. With Cube Voyager’s highly 

flexible network and matrix calculators, you can calculate travel demand and to compare scenarios 

in detail. 

 

An optional extension is available for Cube Voyager: 

• Cube Avenue – Adds dynamic traffic assignment with mesoscopic simulation capabilities. 

Avenue uses standard Cube Voyager commands and scripts with high flexibility, allowing the 

user to tailor the assignment for many purposes and a complete integration with the other 

modules.   

 

Cube Cargo 
Cube Cargo forecasts freight movement. Cube Cargo uses a commodity-based approach for 

analyzing freight demand. You can use Cube Cargo to test a wide variety of policies and 

infrastructure improvements, such as alternative pricing strategies or freight-specific facilities. 
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Cube Cargo works seamlessly with other Cube modules, including Cube Voyager and Cube Analyst. 

Cube Cargo also works with TP+ and TRIPS. With Cube Cargo, you can add freight forecasting to 

your existing passenger data and models. 

 

With Cube Cargo, you can forecast: 

• Tons of goods by commodity type and by transport mode, which you can use to analyze 

flow of goods 

• Number of trucks by truck type, which you can use to analyze truck vehicle flows 

 

Cube Analyst & Analyst Drive 
Cube Analyst estimates and updates statistically optimized trip matrices for base-year automobile, 

truck, and public transit trips. An accurate origin-destination matrix of existing travel is one of the 

most valuable pieces of data for transportation planning. With Cube Analyst, you can manipulate 

extensive data sets and develop or update origin-destination matrices. 

 

Cube Analyst uses mathematical techniques to find trip matrices consistent with observed transport 

demand and traffic counts. With Cube Analyst, you can work more efficiently and generate more 

accurate results than with manual methods. 

 

Cube Analyst Drive builds on the estimation tools provided to the Cube software suite by the Analyst 

module. It is a program with advanced capabilities. Some key differences exist between some of the 

files that are used by the two programs; for example, Analyst Drive uses a different ICP file format 

for the Highway program which has been developed to dramatically reduce the file size for large 

problems. Analyst Drive also introduces dynamic matrix estimation with Cube Avenue, simultaneous 

estimation of multiple user classes, 64-bit support, and increased performance through multi-

threading. 

 

Cube Land 
Cube Land simulates the real estate market to predict detailed information about household and 

employment by zone or parcel. Cube Land takes into account information about demand, real estate 

supply, transport accessibility, other zonal or parcel attributes, regulations, and economic incentives. 

You can easily integrate Cube Land into existing transportation planning models and can apply Cube 

Land for either long- or short-term horizons to model the interaction between land use and 

transportation.  
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2.3 Working Environment 

This section describes: 

 

• Key Features 

 

• Window Management 

 

• Developer and Applier Mode 

 

Key Features 
Cube Base supports all the Cube modules previously introduced. The Cube Base interface is 

modifiable and may appear in several different formats. The windows that appear within the 

workspace depend on selected files or by enabling/disabling features. Users can move and dock 

windows or embed them in the same space.   

 

The interface is primarily made up of the following components: 

• Ribbon — The commands displayed in the ribbon change depending on the type of file 

currently open, and the task at hand. The ribbon features: 

o Tabs — a ribbon tab displays a toolbar of related commands. Different tabs will 

appear depending on the file context. 

o Groups — Ribbon commands within a tab are grouped when they have closely-

related functions. 

o Caption Button — Caption buttons are located on the lower-right corner of many 

groups. Clicking the caption button brings up a settings window related to the 

group’s function. 

• Scenario Manager — For managing alternative scenarios, associated input and output 

data and reports. The Scenario Manager includes: 

o Scenario Window – Lists user defined scenarios. Use this section to develop or 

edit scenarios and to run the model. 

o Data Window – Shows and organize input and output data and reports for each 

scenario. Open and organize data sources (maps, tables, geodatabases, etc). 

o Keys Window – Lists the Catalog Keys available for this particular catalog. From 

this pane, you may also modify, add, or remove keys.  

• Application Windows — For building and documenting the model process through a tree 

structure and a flow chart interface:  

o App Window – Tree structure for the application or the multiple applications linked 

to the catalog. 

o Application Manager – Flow-chart interface for the development and display of 

your actual model. 

• Data Manager — For organizing and opening data sources, including maps, tables, 

geodatabases, and more. 

• Workspaces: 

o Mapping Window — For developing and editing transportation networks, and 

producing charts and maps. 

o Table Window — For viewing and editing data in tabular format. 

o Script/Text Editor — For creating and editing script and text files.  
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Figure 2 Cube Windows 

 

Window Management 
Cube manages open windows by two means: the Tabbed Window Interface and the Legacy 

Interface. 

• Tabbed Windows Interface: convenient tabbed window interface to organize your 

workspace. As shown below, you may click the down arrow icon to view a list of all open 

windows tabs (when many are open). You can close the currently selected tab by clicking 

the “x” next to the down arrow. You may also select the “x” within the tab to close the 

associated tab. 

 

 
Figure 3 Tab bar menu 

• Multi-Document Windows Interface: alternately, Windows can be arranged in the script 

like in Figure 2. This can be changed by unselecting “Tab Mode Toggle” or going to File > 

Options > General tab, and unselecting “Display Windows as Tabs.” In this mode, selecting 

an individual window makes that window the active window. Once in this mode, you can 

open multiple windows of different file types simultaneously using the View ribbon tab. 

There you will find commands to cascade windows, tile them, minimize all, and more. 
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Developer and Applier Mode 
Through Cube Base, you can operate Cube in two modes: 

 

• Developer mode: you can use Application Manager to design a model structure and 

manipulate the associated data. Application Manager offers a flow-chart interface for 

designing and documenting model processes (Figure 4). Model developers can also create 

user interfaces for those who apply or run the model. 

 

 
Figure 4 Application Manager Window for the Cubetown Demonstration Model 

• Applier mode: you can view the process flow chart, edit selected inputs, and run the model. 

Model appliers do not edit the process flow chart. Model appliers evaluate alternatives by 

creating scenarios in Scenario Manager and defining the associated inputs in the Scenario 

Panel Window (Figure 5), which is designed by the model developer offering model appliers 

the choices needed for developing and testing scenarios.  
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Figure 5 Scenario Panel Window for the Cubetown Demonstration Model 
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2.4 Integration with ArcGIS 

The primary mapping window is the GIS window. The GIS window uses the ESRI ArcGIS engine to 

display a map depicting the geographic information stored in geodatabases, shapefiles, CAD format 

files, and raster images, as well as other map elements that you specify or create. 

 

 
Figure 6 Cube GIS Window for the Cubetown Demonstration Model Network 

The GIS window represents geographic information as a collection of layers along with defined 

elements in a map, including a background map from ESRI ArcGIS online services. You can save 

map documents (MXDs), share them with other analysts who can use the data within ArcGIS, and 

easily bring the data back to Cube for further modeling and simulation. 
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2.5 Integration of the Cube Modules 

The Cube modules — Cube Voyager, Cube Avenue, Cube Cargo, Cube Land, Cube Analyst/Analyst 

Drive — can be accessed from the Ribbon menu of Cube Base’s Application Manager window. Other 

legacy products from Citilabs, such as TRIPS, TP+, and Tranplan, can also be found here, under 

the “Legacy” drop-down menu. 

 

 

 
Figure 7 Access to Cube Modules and Legacy Products 

 

From Application Manager, you can use the Cube modules and other integrated products as 

functions when developing a modeling and simulation process. You can also integrate other “User 

Programs,” such as specialized routines in C++, C, Fortran, Python, or any other programming 

language, in the same way. Finally, you can integrate third-party software products. 
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3 Getting Started  

This chapter lists resources for the tutorial and introduces you to how to get started with the Cube 

application. Topics include: 

• The Components Required for This Tutorial 

• Opening the Discover Cube Catalog 

 

3.1 Components Required for This Tutorial 

To get started, you will need the following: 

• The Discover Cube Tutorial 

• Cube software 

• Cubetown dataset 

 

Discover Cube Tutorial 
The Discover Cube Tutorial is the document that you are reading though. A copy of this can be found 

in the following locations: 

• Installed with the Cubetown data installer in the folder “C:\Cubetown\Tutorial” 

• Available to download from the Citilabs Learning Center  

http://www.citilabs.com/support/learning-center   

 

Cube Software  
It is necessary to install the software and data before proceeding to the exercises. Cube may be 

installed from an executable downloaded from Citilabs website. Follow the installer’s directions to 

install the software. In order to complete the tutorial for all the modules, you should have installed 

and licensed: 

 

• Cube Base 

• Cube Voyager 

• Cube Cargo 

• Cube Land 

• Cube Analyst  

• Cube Avenue 

 

Cubetown dataset 
The Cubetown dataset is available for learning purposes. In order to complete this tutorial, you will 

need to download the data from the Citilabs Learning Center and install it by running the executable. 

 

NOTE:  While installing Cubetown data files, the installation wizard will present an option to alter the 

directory where the files will be installed. We suggest you keep the default option. The file paths 

provided in the tutorial exercises assume you installed Cubetown data in the C:\Cubetown directory. 

  

http://www.citilabs.com/support/learning-center
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3.2 Opening the Discover Cube Catalog 

Cube stores applications and scenarios in a catalog. The exercise in this section guides you through 

opening the catalog that contains the exercise’s data, the Discover Cube catalog. 

▪ To open the Discover Cube catalog and model 

1 Open Cube. 

▪ Start Cube. You can double-click the Cube icon on your desktop or click the 

Start button, point to All Programs, point to Citilabs, and choose Cube. 

▪ Cube displays the Welcome to Cube dialog box. 

 

 
Figure 8 Welcome Screen 

2 Open the Discover Cube catalog 

▪ Select Discover Cube Catalog under Demonstration Model (Figure 8)  

▪ Alternatively, you can open the C:\Cubetown folder and open the Discover 

Cube Catalog File. 

Note: In this tutorial, we will refer to the four windows that are opening on the 

left of the Cube Window as “Scenario Manager”. 

 

When the catalog file has been opened, you will notice that the interface changes to include several 

windows and a toolbar. The catalog shows the scenarios, data, and applications or models used with 

the Cubetown demonstration models. The windows will be auto-filled with the contents of the 

scenarios selected from the catalog.  
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When opening the model, the “Cubetown_RefSheet” (Figure 9) should be displayed in the main 

window or can be opened by the user by double-clicking on it under the App Window on the left of 

the Cube Window (in Scenario Manager). The reference sheet is a quick guide to the different 

applications available with the Cubetown dataset. This reference sheet can be accessed at any time 

from the App Window. 

 

 
Figure 9 Discover Cube Catalog Reference Sheet 
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4 Exploring Cube Base and Cube 

Voyager 

You can use Cube to develop data, run scenarios, and examine and analyze outputs. This chapter 

contains a series of exercises that help you explore tasks you might complete with Cube Base and 

Cube Voyager. Topics include: 

 

• Maps 

 

• Models 

 

• Highway networks 

 

• Public transit 

 

• Demographic data 
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4.1 Maps 

Cube Base displays geographic information in a map. You can use Cube Base to work with maps 

and analyze data. This section contains an exercise that demonstrates how you might use Cube 

Base to display a network, add new layers from ArcGIS Online or a geodatabase, adjust the map 

display, and save a map document. 

 

▪ To visualize a mapping window in Cube GIS, you can expand the Input > Voyager folder 

within the Data Window, and double click on the “HW Network Function Class” map, this will 

display the map shown in Figure 6. 

 

▪ To create an ArcGIS map document 

1. Open the input highway network. 

▪ Under the Data panel in Scenario Manager, click the “plus” symbol to expand 

Inputs and Voyager. 

▪ Double-click HW Network. 

Because the input highway network is a custom feature data set stored in an 

ESRI personal geodatabase file, Cube opens the input highway network in a 

new GIS map window. The window shows the map and a table of contents, 

which lists the layers in the map. 
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Figure 10 Cube GIS Window with Cubetown Highway Network 

2. Add a geodatabase feature class to the map. 

▪  From the Home ribbon tab, click Add Data and choose Geodatabase 

Data. 

▪ A file browser will open. Navigate to C:\Cubetown\Inputs\cubetown.mdb. 

▪ In the right-hand pane, double-click Demographics to add a transportation 

analysis zone (TAZ) layer to the map. 
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Figure 11 Cube GIS Window with Cubetown Highway Network and Demographic Data 

3. Add an ArcGIS Online layer to the map (requires Internet access). 

ArcGIS Online is a free service provided by ESRI including background imagery that 

can be loaded using an internet connection. To find out more, visit 

www.esri.com/arcgisonline  

▪ From the GIS toolbar select Add Data  

▪ Select Server Data and expand “arcgis on services.arcgisonline.com” 

 

http://www.esri.com/arcgisonline
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Figure 12 Adding Basemaps from services.arcgisonline.com 

As a quicker alternative, the Maps Ribbon provides with the most-commonly 

used Basemaps from arcgisonline 

 

 
Figure 13 Adding Basemaps from services.arcgisonline.com using the Maps Ribbon 

You can select one of those Basemaps, provide with a name for the Layer 

that you are adding to your map, and click Save. 

 

 
Figure 14 Add Layer Template window to add Basemaps 
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Cube adds the World Imagery layer to the map. Cube loads the imagery 

shown in the layer from ESRI’s ArcGIS Online service using your Internet 

connection. 

 
Figure 15 World Imagery layer in the Cube GIS window 

4. Use the table of contents to adjust the map display. 

▪ Drag the Demographics layer to the top of the list. 

Cube redraws the map, displaying the TAZ boundaries on top of the imagery. 

 

 
Figure 16 World Imagery layer in the Cube GIS window – Demographics on top 
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▪ Drag the NoBuild network group layer to the top of the list. 

NOTE: Do not move the NoBuild_Node or NoBuild_Link layers outside the 

NoBuild group.  

Cube redraws the map with the network shown on top of the TAZ boundaries 

and background imagery. 

 

 
Figure 17 World Imagery layer in the Cube GIS window – HW Network on top 

5. Use the toolbar buttons to adjust the map display, as desired. You might: 

▪ Turn off one or more layers 

• Clear a layer’s check box in the table of contents, to hide the layer from 

the displayed map. 

▪ Zoom to a particular area 

•  Click the Fixed Zoom In button one or more times to zoom in by 

a fixed amount. 

•  Click the Zoom In button and draw a box around the desired area 

of focus on the map. 

▪  Switch back and forth between two views using the Go Back to 

Previous Extent and the Go to Next Extent buttons. 

▪ View the entire set of active layers by clicking the Full Extent  button. 

 

6. Save your work as a map document so that you can retrieve it later. 

▪ From the File menu, choose Save As. 

▪ In the Save As dialog box, navigate to the directory where you save maps and 

enter the name of the file. 

▪ Click Save. 

7. From the File menu, choose Close to close the map.  
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Predefined Output Maps 
A set of predefined output maps, displaying the results of the scenarios, are created from ArcGIS 

Map Document (MXD) templates, and are available when you run any new scenario under Outputs 

> Maps in the Data Window. 

 

 
Figure 18 Data Window – Predefined Maps 

The two key elements to define map templates are: 

• An MXD file saved with relative reference to the input geodatabase layers (scenario specific 

folder) 

• A VPR file associated to the geodatabase datasets for Cube visualizations (Results.vpr in 

the scenario specific folder) 

▪ To open the predefined “Transit Loadings” map 

1. Select the “Base” scenario in Scenario Manager with one left-click. 

2. Open the available maps: 

▪ Under the Data panel in Scenario Manager, click the “plus” symbol to expand 

Outputs and Maps. 

▪ Double-click “Transit Loadings”. 

Cube opens the map in a new GIS map window. The window shows the map 

on top of an ESRI basemap, and a table of contents, which lists the layers in 

the map. 

▪ It is also possible to deactivate the tabbed mode, switching to the multi 

document visualization and compare different maps within the same window.  

 
▪ An example is given by opening again the same “Transit Loadings” map in a 

different GIS window and using “Tile Vertically” to set the visualization side-

by-side, activating different layers (Figure 19). 
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Figure 19 Non-Transit and Transit Loading Maps in the Cube GIS window with Dark Gray Canvas Basemap 
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▪ To open the predefined “Productions by Purpose” map and look at the Layout View 

1. Double click on “Productions by Purpose” under Output > Maps in Data Window 

 

 
Figure 20 Production by Purpose and Volume Bandwidths in the Cube GIS window with World Topology Basemap 

 

2. Under the Layout Toolbar, click the Layout View button to visualize the map switching 

to the layout view 

 
3. This map can be easily printed, for example to a PDF document, by clicking on File > 

Print > Print… and selecting the desired printer name 
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Figure 21 Production by Purpose and Volume Bandwidths in the Cube GIS window with World Topology Basemap – 

Layout View 
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▪ To open the predefined “Intersection LOS” map 

1. Double click on “Intersection LOS” under Output > Maps in Data Window 

 

 
Figure 22 Intersection LOS in the Cube GIS window with Light Gray Canvas Basemap 

 

2. To be able to update the junctions display, it is necessary to associate the output 

junctions data to this network in the GIS environment. To do so select the 

CombinedOutputs layer with the TOC and click on Intersections > Output file (within 

the Cube ribbon) 

 
3. Select the TURNS.INT file browsing to the Cubetown\Base folder (scenario specific). 

 

▪ To open the predefined “Link Volume and Speed” map 

1. Double click on “Link Volume and Speed” under Output > Maps in Data Window 

(Figure 23) 

2. Note that the bandwidths specification can be changed via Analysis > Multi-

Bandwidth… within the Cube Ribbon, in this example, the bandwidth width is 

specified using the traffic volumes, whilst the coloring is specified using the congested 

speed under Dynamic Color and clicking on the Color box 

 

▪ The last predefined map that you can explore for now is “Land Use Forecast” 

3. Double click on “Land Use Forecast” under Output > Maps in Data Window (Figure 

24) 
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Figure 23 Link Volume and Speed Map in the Cube GIS window with Dark Gray Canvas Basemap 

 

 

  



Discover Cube Tutorial  29 
 

 
Figure 24 Land Use and Traffic Volume Map in the Cube GIS window with World Street Basemap 
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4.2 Models 

Transportation planning models require a structure that allows you to study the effects of varying 

inputs. In Cube, that structure consists of: 

 

• Applications — Applications describe the model Cube uses to process data. You use 

Application Manager to develop models. You save the models as applications. 

• Scenarios — Scenarios link a specific set of inputs to an application. You develop scenarios 

to apply applications. A scenario links a specific set of inputs to an application. 

• Catalogs — Catalogs store related applications and data. You create catalogs as the 

container for your work. Catalogs provide convenient access to the applications and 

scenarios you need to complete a study. 

 

This section guides you through exercises that demonstrate how you work with applications, 

scenarios, and catalogs to run a transportation planning model. Topics include: 

 

• Getting started 

• Understanding the model 

• Running an existing scenario 

 

Getting started 
Cube stores the applications and scenarios you use for a study in a catalog. The exercise in this 

section guides you through opening the catalog that contains the exercise’s data, the Discover Cube 

catalog, and examining the catalog’s Cube Voyager model. 

 

▪ To open the Discover Cube catalog and model 

1 Open the Discover Cube catalog. If Cube is already open: 

▪ From the File menu, choose Open. 

▪ In the Open File dialog box, navigate to the C:\Cubetown directory, select 

Discover Cube.cat, and click Open. 

If Cube is not open: 

▪  Open Cube, such as by double-clicking the desktop icon or by clicking the 

Start button and navigating to the Cube application. 

▪  In the Welcome to Cube window, select Discover Cube Catalog. 

Cube opens the Discover Cube catalog in Scenario Manager. A catalog stores a set 

of models, data, and scenarios. 

 

Scenario Manager has four panes: 

▪ Scenarios — Lists defined scenarios. Use this section to develop or edit scenarios and to 

apply the model. 

▪ Data — Shows input and output data for each scenario. Use this section for easy access to 

these files. 

▪ Applications — Lists the available model processes. Use this section to select the model you 

wish to use. 

▪ Keys — Lists the Catalog Keys available for this particular catalog. From this pane, you may 

also modify, add or remove keys. 
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To forecast personal travel in this exercise, we will use the Cube Voyager Demonstration Model. 

 

2 Under App, double-click Cube Voyager Demonstration Model. 

A new window, called Application Manager, opens showing a flow-chart view of the 

model process. 

 

 
Figure 25 Scenario Manager and Application Manager 

The applications within the Applications Window are the main applications containing the different 

models, with their model steps. 

 

Understanding the model 
The Cube Voyager Demonstration Model is a “four-step” model consisting of: 

• Trip generation 

• Trip distribution 

• Mode split (mode choice) 

• Trip assignment 

 

The model has other steps for Initialization (developing networks, initializing variables, etc.) and 

Output Postprocessing (analyzing the results). 

 

Cube is an open and flexible tool. Cube enables model developers to build models using almost any 

model structure, including emerging methods in activity models and tour-based approaches. The 

four-step model used in the demonstration system is the most commonly used structure by analysts 

around the world. 
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The flow chart represents model steps with two different types of boxes: 

• Sub-Groups (or Sub-Applications) boxes: are customized boxes, nested within the main 

application, providing the overall structure of the model by grouping together actual model 

steps. Sub-Groups may contain other Sub-Groups, with custom structure and content.  

 

To “enter” the Sub-Group and visualize its content, you can double-click on it in the 

Application Manager flow chart. 

 

 
Figure 26 Scenario Manager and Application Manager 

• Program boxes: are the actual model steps from a library of available programs or user-

define programs 

 

 
Figure 27 Cube Voyager > Public Transport program box “inside” the Initialization Sub-Group 

To the left of each step are light blue boxes, which show inputs to the step. To the right of each step 

are green boxes, which show the outputs from the step. Links show where outputs from one step 

become inputs to another step.  

 

The inputs and outputs boxes for each Sub-Group that are visible at the “parent” level of the 

application nested structure are defined by the modeler by “making them public”. Whilst the inputs 

and outputs for each program are defined by the user using the inputs and outputs that are available 

for every specific program. 
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Figure 28 Input and Output boxes and linkage 

The model has a loop around the Distribution, Mode-Choice, and Assignment steps. This is called a 

“feedback loop” – the model takes the travel times from the assignment model (the congested travel 

times) and inputs those travel times to the distribution step, redistributing the trips using the 

congested times. The model also inputs the congested travel times to the mode-choice step. The 

model iterates between these steps until it meets certain user defined equilibrium criteria. 

 

You can click an output or an input to see how they relate to each other in the loop, they will properly 

be highlighted to show the linkage. 

 

 
Figure 29 Input and Output boxes and linkage through the Loop (Distribution, Mode Choice and Assignment) 
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Running an existing scenario 
The Cube Voyager Demonstration Model studies a town called Cubetown. We will use the model to 

study impacts associated with a new road. The model contains a predefined scenario, the Base 

scenario. Base scenario models existing conditions in Cubetown. 

 

In the exercise in this section, you will run a scenario to compute the traffic generated based on the 

current inputs and examine various outputs. 

▪ To run the Base scenario 

1 In Scenario Manager under Scenarios, double-click Base. 

Cube opens the scenario window for the Base scenario. You use this window to run 

and manage the scenario. 

 

 
Figure 30 Scenario Panel (or Scenario Window) for the Base Scenario 

Working in Cube’s developer mode, model developers configure the colors, logo, 

explanatory text, and input fields most appropriate for the model. 

 

2 From the scenario window, click Run. The Task Monitor window opens and shows 

the progress of the model run. 

 

When the run is complete, the Task Run Result dialog box opens. 
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Figure 31 Task Monitor showing progress run for  the Base Scenario 

 

3 Click OK. 

 

The dialog box and the Task Monitor window closes. Next, we will examine the 

results. 

 

4 Under Data in Scenario Manager, click  to expand Outputs, Voyager, and Highway 

Assignment. 

 

 
Figure 32 Data Window - Output structure 
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5 Open the highway output network by double-clicking HW Loads. 

 

The GIS window opens, showing the loaded highway network and estimated flows 

for the tested scenario. 

 

6 Add volume bandwidths to visualize traffic loads on the map. 

▪ Select the CombinedOutputs layer in the table of contents. 

▪  From the GIS Analysis ribbon tab, choose Multi-

Bandwidth. 

▪ The Highway Layer Link Bandwidth Settings dialog box opens. 

 

 
Figure 33 Highway Layer Link Band Width Settings dialog box 

▪ Verify that the settings show the volume. 

 
Property Value 

  

Set 3: Volume Bandwidth 

Attributes V_1 

Value / pixel 100 

Selection Criteria FUNC_CLASS=1-9 
  

 

NOTE: You can right-click in the Selection Criteria edit box to select 

FUNC_CLASS from a list of available variables. 

▪ Click OK. 

 

The GIS window updates to show the bandwidth display. 
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Figure 34 Multi Bandwiths for the HW Assignment for the Base Scenario 

7 Close the map, scenario window, and Application Manager. Save the map (.mxd), if 

desired. 
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4.3 Highway networks 

Cube Base includes network-editing tools. This section contains exercises that demonstrate how 

you can use these tools when working with a highway network: 

• Improving network quality 

• Changing the road network 

 

Improving network quality 
Cube Base includes tools that help you improve the quality of your network. For example, your 

network might simplify links with a straight line between two points. With Cube Base, you can snap 

the links to an underlying shape data and add vertices to better represent actual road shape and 

distances. 

 

This section contains an exercise that shows how you can use vertex editing to properly apply true 

shape to a freeway interchange in the Cubetown model. 

▪ To use vertex editing to apply true shape to a freeway 

1 If necessary, open the Discover Cube catalog. 

Refer to “To open the Discover Cube catalog and model” on page 13. 

2 Open the highway network for the Build Road scenario. 

▪ Under Scenarios in Scenario Manager, expand Base, and select Build Road. 

▪ Under Data, expand Inputs and Voyager, and double-click HW Network to 

open the network feature data set for the Build Road scenario. 

 

Cube opens a GIS window showing a map of the scenario’s highway network 

input. Currently, the network uses a straight link to represent a cloverleaf 

interchange. 

 

3 Add highway centerline data to the map. 

▪  From the Home ribbon tab, click Add Data and choose Geodatabase Data. 

A file browser window opens. 

▪ Navigate to C:\Cubetown\GIS and select MapElements.mdb. 

▪ Under Datasets, select RoadCenterline. Click Open to add a new layer to the 

map containing the feature. 

4 Focus the display on the freeway interchange. 

▪  Click the Select Features tool. 

▪ Click and drag a small box in the interchange near the center of the network, 

selecting the freeway ramps. 
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Figure 35 Selected interchange for the Build Road Scenario network 

Feature Explorer opens, showing the selected features. 

▪  Click the Zoom To Selected Features button to focus on that area. 

5 Set the window to editing mode for the proper layer. 

▪ On the Editing toolbar, click the Editor button, and choose Start Editing. 

 
The Editing toolbar becomes active. 

 

▪ Click the Editor button and select two operating modes: Vertex Snap and Edit 

Vertex. 

▪ In the Layers drop-down list, select Build_Link, the layer where we will edit the 

vertices. 

 
6 Add the cloverleaf shape to the straight-line link. 

You can: 

▪ Edit the existing straight-line link to include multiple vertices. 

•  Verify that the Edit Feature button is selected. 

• Click the straight-line freeway-to-freeway connector link. 
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Feature Explorer shows the selected link. 

• To add a vertex to the link, press SHIFT and click. 

• To move the vertex to the underlying highway-network centerline 

feature, click the vertex and drag. 

The new vertex will snap to the vertices of the underlying feature. 

 
• Repeat steps c and d until the curvature of the freeway ramp is correct. 

 
▪ Copy the shape from the road centerline feature to the link. 

• If you already added the shape with vertexes, click the Undo button 

until the link is no longer shaped like a cloverleaf. 

•  Verify that the Edit Feature button is selected. 

• Click the straight-line freeway-to-freeway connector link. 

Feature Explorer shows the selected link. 

• In Feature Explorer, click the Copy Shape From Another Feature  

button. 

• Click the line feature with the shape that you want to copy - in this 

case, the cloverleaf centerline.  

Cube Base copies the shape to the link. 

 
7 Save edits and exit editing mode. 

▪ Click the Editor button and choose Save Edits. 

Cube uses nondestructive editing. You can review your changes before 

saving them. This reduces the likelihood of data corruption. 

▪ Click the Editor button and choose Stop Editing. 

8 Close the GIS window. If the desired, you can save the current map document. 
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Changing the road network 
This section contains an exercise that demonstrates how you might modify network data to include 

a new road link, and use that network in a different scenario, the Build Road scenario, to examine 

the changes that occur after adding a new road to the network. 

▪ To modify a road network 

1 Open the scenario’s highway network. 

▪ Under Scenarios in Scenario Manager, expand Base, and double-click Build 

Road to open the scenario window for the Build Road scenario. 

▪ Click the Edit button for the highway network input. 

Cube opens a GIS window showing a map of the scenario’s highway network 

input. 

Currently, the network is missing one segment on the new road. 

2 Focus the map near the new road segment. 

▪  Click Zoom In and select the area at the top-center of the map, where 

there is a missing section of road. 

 

▪  Click the Select Features tool and draw a box around the missing link. 

 
Cube selects the nodes within the box, and opens Feature Explorer to show 

information about those nodes and associated links. 

 
▪ Close Feature Explorer. 

3 Display the node information on the map. 
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▪  Click the Zoom To Selected Features button. 

Cube updates the view in the map window to focus on the selected area. 

▪  On the Home ribbon tab, Post GIS Node group, Click the Post button. 

 

Cube opens the Posting Selection dialog box. 

 

 
Figure 36 Posting Selection dialog box 

▪ In Set, select 3:Post all nodes, and verify the options to display node numbers 

on the network. 

 
Field Description 

  

First attributes drop- Select N to post node numbers. 

down list  

Offset Select the check box to place the label next 

 to the node rather than directly on the node. 

Symbol/Font Style If desired, select a font from the ESRI style list. 

Use Built In Font If desired, select this check box to render 

 fonts using the ESRI default font. 

Use Built In Font Size If desired, select this check box to scale text 

 using the ESRI default font size. 

Simple Posting If desired, select this check box to use a 

 single color and reduce the time required to 

 post labels. 

Color If desired, click the Color box to open the 

 Color dialog box, where you can select a 

 color for the node number. 

Selection Criteria Clear to label all nodes on the map. 
  

 

▪ Click OK. 

Cube displays the node numbers. 

 
4 Select an existing link as a template for the new link. 
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▪ On the Editing toolbar, click the Editor button and choose Start Editing. 

 
The Editing toolbar becomes active. 

▪  Verify that the Edit Feature button is selected. 

▪ On the Layers drop-down list, choose Build_Link as the type of feature to 

select. 

▪ Click link 1218-771. 

Feature Explorer opens showing the properties of that link. Select one of the 

two directions on the left side of Feature Explorer. 

▪  Click the Set Current Feature Attributes as Template button. 

Cube copies the attributes of the selected link into memory. Any new links that 

you create will copy this link’s attributes, simplifying required data entry. 

5 Add a new link. 

▪ Click the Editor button and enable Endpoint Snap to snap new links to existing 

nodes when possible. 

▪  Click the Create Feature button. 

▪ On the Layers list, verify that Build_Link is selected as the type of feature to 

create. 

▪ Click node 1351. 

The cursor mode changes to a drawing mode. 

▪ Move the cursor to node 1218 and double-click node 1218. 

 
Cube draws the new link and opens Feature Explorer for the new link. 

 
Figure 37 Feature Explorer for the new link 
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For the selected feature, Feature Explorer lists field values. When multiple 

features are selected, Feature Explorer lists the range of values contained in 

a field – that is, the minimum and maximum values of the field among all the 

selected features. Press CTRL and click to select a feature or cancel a 

selection. 

 

While working in edit mode, you can edit values in Feature Explorer. When 

you select multiple features, Feature Explorer adds a New Value column to 

enter values. Cube applies any value entered to all currently selected features. 

 

6 Save the data for the new link. 

▪ On the Editing toolbar, click the Editor button, and choose Stop 

Editing. 

▪ Click Yes when prompted to save your edits. 

Cube uses nondestructive editing. You can review your changes before 

saving them. This reduces the likelihood of data corruption. 

NOTE: You can automate many common network processing tasks using the 

Cube Voyager Network program. For more information, see Chapter 8, 

“Network Program,” in the Cube Voyager Reference Guide. 

7 Close the GIS window. 

At the prompt to save the map document, click No. 

8 Run the Build Road scenario. 

▪ From the scenario window, click Run. 

If you need to open the scenario window, simply double-click Build Road 

under Scenarios in Scenario Manager. The Task Monitor opens, displaying 

the run status. 

When the run is complete, the Task Run Result dialog box opens. 

▪ Click OK. 

The dialog box and the Task Monitor window closes. 

9 Open the output network. 

▪ Under Data in Scenario Manager, click  to expand Outputs, Voyager, and 

Highway Assignment. 

▪ Double-click HW Loads to open the loaded highway output network. 

The GIS window opens, showing the loaded highway network for the scenario. 

Cube Voyager generates a path file that lists the paths the Highway program 

used. By querying selected links, you can analyze trips that use the added 

road segment. 

10 Examine the paths built during the Cube Voyager run. 

▪ Select the CombinedOutputs_Link layer in the table of contents. 

▪ From the GIS Analysis ribbon tab, choose Add Path File. 

▪ In the Open Highway Path File dialog box, navigate to 

C:\Cubetown\Base\Build Road, select ROADPATHS.PTH, and click Open. An 

Information dialog tells you about the data processed. 

▪ Click OK. 

A Path File dialog bar opens above the map. 

▪ Configure the settings as in the next table. 
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Property Value 

  

Mode Selected Links 

Origin All 

Iterations All 

Destination All 

Sets All 

Selected Links/Nodes L=771-1215* 
  

 

▪ Click Display. 

The map updates to show how traffic on the new link distributes across the 

network. 

NOTE: You can also create customized traffic assignment procedures and 

analyses, such as select link and subarea extraction, using the Cube Voyager 

Highway program. See Chapter 6, “Highway Program,” in the Cube Voyager 

Reference Guide. 

11 Repeat the same procedure for steps 9 and 10 opening the Base Scenario loaded 

network (select the Base Scenario in Scenario Manager) and path file 

(C:\Cubetown\Base\ROADPATHS.PTH) 

12 Compare the two maps 

▪ Click on Customize quick access toolbar (black arrow) and select Tab Mode 

Toggle 

 

▪  Deselect the Tab Mode Toggle 

▪  Click on Tile Vertically 

▪  Click on Synchronize Windows 

▪ Observe the difference between the results of the two assignment, different 

traffic patterns due to the opening of the new road. 
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Figure 38 Comparison of the Select Link Analysis Base Vs Build Road Scenarios 

13 Save and close the map. 

▪ Click File > Save. 

▪ In the Save As dialog box, navigate to the directory where you save maps, 

enter the name of the file, and click Save. 

NOTE: Cube saves the graphic representation of the path with this map, but 

does not save the link to the data with the map. If you update the path data in 

the future, the map will not update. 

▪ From the File menu, choose Close to close the map. 
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4.4 Public transit 

Cube Base enables you to import, view, edit, and create data for public transit networks. You can 

model public transit with Cube Voyager’s Public Transport program. This section contains an 

exercise that demonstrates how you might modify data for a public transit line, run a model, and view 

results. 

▪ To work with public transit data 

1 Open the Increase Transit scenario’s transit line network. 

▪ Under Scenarios in Scenario Manager, expand Base, and double-click 

Increase Transit to open the scenario window for the Increase Transit 

scenario. 

▪ Click the Edit button for the public transit lines input (Headway dataset). 

▪ Cube opens a GIS window showing a map with the scenario’s highway 

network (NoBuild) and public transport network inputs (Headway). In the TOC 

the main layer is called NoBuild (HW network), and the associated PT services 

are stored in three separate layers: Headway_PTLine, Headway_PTNode 

and Headway_PTLink. 

 

 
Figure 39 Cube GIS Window with the Headway PT Network over the NoBuild HW Network 

2 Edit the headway for the Red line. 

▪ Click the Editor button and choose Start Editing. 

▪  Verify that the Edit Feature button is selected. 

▪ In the Layers list, select Headway_PTLine. 

▪ Click the Red line on the map. 
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▪ Cube highlights the line and opens Feature Explorer for that line. 

▪ Change the value of HEADWAY_1 from 15 minutes to 3 minutes to reduce 

the line’s headway, thereby increasing the frequency of service. 

  
Figure 40 Feature Explorer for the Red Line – HEADWAY_1 modified from 15 minutes to 3 minutes 

▪  Click the Save Current Item button to save the change. 

3 Save the edits to the database and close the GIS window. 

▪ Click the Editor button and choose Stop Editing. 

▪ On the Confirm dialog box, click Yes to save your edits. 

▪ From the File menu, choose Close to close the GIS window. You need not 

save the current map document. 

4 Run the Increase Transit scenario. 

▪ If necessary, double-click Increase Transit under Scenarios in Scenario 

Manager to open the scenario window. 

▪ From the scenario window, click Run. 

The Task Monitor opens, displaying the run status. 

When the run is complete, the Task Run Result dialog box opens. 

▪ Click OK. 

The dialog box and the Task Monitor window closes. 

5 Examine the transit load results using the bandwidth display. 

▪ Under Data in Scenario Manager, click  to expand Outputs, Voyager, and 

PT Assignment. 

▪ Double-click Transit Loads to open the public transit output. 

The GIS window opens, showing the assigned network and estimated loads 

for the tested scenario. 

▪ Add volume bandwidths to visualize transit loads on the map. 

• In the table of contents, select TRNLOADS_PTLink. 

•  From the GIS Analysis ribbon tab, choose Multi-Bandwidth. 

The Transit Layer Link Band Width Settings dialog box opens. 
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• In the Attributes list, select VOL_1. 

• Click OK. 

The GIS Window updates to show the bandwidth display, representing 

loads on transit lines. 

 

 
Figure 41 Multi-Bandwidths for the PT Assignment for the Increase Transit Scenario 

NOTE: You can use the Cube Voyager Public Transport program to define customized transit choice 

behavior models with multiple user classes. For more information, see Chapter 12, “Public Transport 

Program,” in the Cube Voyager Reference Guide. 

 

6 Save and close the map. 

▪ Choose File > Save. 

▪ In the Save As dialog box, navigate to the directory where you save maps, 

enter the name of the file, and click Save. 

NOTE: Cube saves the graphic representation of the load bandwidths with 

this map, but does not save the link to the data with the map. If you update 

the load data in the future, the map will not update bandwidths. 

▪ From the File menu, choose Close to close the map. 
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4.5 Demographic data 

Cube Base includes tools that helps you work with demographic data. For example, you can create 

thematic maps that help you visualize geometric relationships of demographic data. 

 

Topics in this section include: 

 

• Creating maps from demographic data 

 

• Running demographic-based scenarios 

 

Creating maps from demographic data 
This section contains an exercise that demonstrates how you might create a thematic map, which 

helps you visualize the number of households in different zones of a city, and how you might update 

that data with Cube Base. 

▪ To create and update maps based on demographic data 

1 Open the Land Use scenario’s demographic data. 

▪ Under Scenarios in Scenario Manager, expand Base, and double-click Land 

Use to open the scenario window for the Land Use scenario. 

▪ Click the Edit button for the demographic data input. 

Cube opens a GIS window showing a map with the scenario’s demographic 

zones. 

 

 
Figure 42 NewLU Demographic Data visualized as polygon layer in Cube GIS 
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2 Add network data to the map. 

▪  From the Home ribbon tab, click Add Data and choose Geodatabase Data.  

A File Browser opens. 

▪ Navigate to the C:\Cubetown\Inputs directory and select the Cubetown.mdb 

geodatabase. 

▪ Under Datasets, select NoBuild. 

▪ Click Open to close File Browser and open the data. 

3 Create a thematic map. 

▪ In the table of contents, select the NewLU polygon layer. 

▪  From the Analysis ribbon tab, click Thematic Map. 

▪ The Thematic Map Setup dialog box opens. 

 
▪ Set the properties to configure the desired map. 

 
Property Value 

  

Expression Right-click and choose HOUSEHOLDS 

Color Double-click the box to open the Color dialog 

 box, where you can choose a color. 

 Select a lightest color and a darkest color as 

 desired. 

Groups 3 

Round increments to 100 

nearest  
  

 

▪ Click Color On to generate the thematic map. 

The GIS window updates to show the thematic map. 
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Figure 43 NewLU Demographic Data Thematic Map in Cube GIS 

4 Add zone numbers to map. 

▪  From the Home ribbon tab, on the Post GIS Node group, choose Post.  

The Posting Selection dialog box opens. 

▪ Verify the settings will show zone labels. 

 

Property Value 
  

Set 1:Zone numbers 

Drop down list TAZ 

 

▪ Click OK. 

5 Increase the number of households in zone 5. 

▪ Click the Editor button, and choose Start Editing. 

▪  Verify that the Edit Feature button is selected. 

▪ In the Layers drop-down list, choose NewLU. 

▪ Click in zone 5. 

Feature Explorer opens, showing attributes of that zone. 
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Figure 44 Demographic Data in Feature Explorer for TAZ 5 

▪ Set the value of HOUSEHOLDS to 2531 (from the current 362 value). 

▪  Click the Save Current Item button to save the change. 

▪ Close Feature Explorer. 

6 Save the edits to the database. 

▪ Click the Editor button and choose Stop Editing. 

▪ On the Confirm dialog box, click Yes to save your edits. 

7 Update the thematic map. 

▪  From the GIS Analysis ribbon tab, click Thematic Map. 

▪ Click Color On to update the thematic map. 

The map updated the color assigned to zone 5. 

8 Save and close the map. 

▪ Click File > Save button. 

▪ In the Save As dialog box, navigate to the directory where you save maps, 

enter the name of the file, and click Save. 

NOTE: Cube saves the thematic map, but does not save the thematic map 

settings. You must redefine the thematic map to update in the future. 

▪ From the File menu, choose Close to close the map. 

 

Running demographic-based scenarios 
Demographic-based studies often involve studying matrix results. This section contains an exercise 

that illustrates how you might analyze results from such a run, by examining the destinations of trips 

generated from zone 5, where we increased the number of households. 
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▪ To run and analyze a demographic-based scenario. 

1 Run the Land Use scenario. 

▪ Select the Land Use scenario, if its scenario manager window is not visible. 

▪ From the scenario window, click Run. 

The Task Monitor opens, displaying the run status. 

When the run is complete, the Task Run Result dialog box opens. 

▪ Click OK. 

The dialog box and the Task Monitor window closes. 

2 Open the matrix results. 

▪ Under Data in Scenario Manager, click  to expand Outputs, Voyager, and 

Trip Distribution. 

▪ Double-click Person Trips to open the trip distribution matrix data. 

A Matrix window opens, showing the person trip data. 

3 Open the loaded highway network. 

▪ Under Data in Scenario Manager, expand Outputs, Voyager, and Highway 

Assignment. 

▪ Double-click HW Loads to open the assigned highway loads output. 

The GIS window opens, showing the loaded highway network. 

4 Link the matrix results to the loaded highway network. 

▪ Select the CombinedOutputs data set in the table of contents. 

▪  From the GIS Analysis ribbon tab, choose Link to Matrix. 

The Set Linkage to Matrices dialog box opens. 

▪ Under Available Linkage, select the open matrix file, 

C:\Cubetown\Base\LandUse\PERSONTRIPS.MAT, and click Add. 

Cube moves the matrix under Current Linkage. 

 
▪ Click Close to close the dialog box. 

5 Post the desire lines that represent the demand from zone 5. 

▪  From the GIS Analysis ribbon tab, choose Desire Lines. 

The Desire Lines dialog bar opens at the top of the GIS window. 

▪ Enter the properties to show desire lines representing demand from zone 5 to 

other zones. 
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Property Value 
  

Matrix Table Right-click and choose M1.T7.TOTA. 

Scale 300 

Loc Fld N 

Orig Exp 5 

Dest Exp 1-25 

Direction option 1-way (O-D) 
  

 

▪ Click Display to add a layer representing these settings to the map. 

 

 
Figure 45 Desire Lines Map from Origin 5 

▪ In the table of contents, clear the CombinedOutputs_Node layer check box to 

simplify the map. 

 

NOTE: You can use the Cube Voyager Matrix program to automate processing of zone-based data 

and other tables. For more information, see: 

• Chapter 9, “Matrix Program,” in the Cube Voyager Reference Guide 

• Chapter 10, “Distribution Program,” in the Cube Voyager Reference Guide 

• Chapter 11, “Generation Program,” in the Cube Voyager Reference Guide 

• Chapter 5, “Fratar,” in the Cube Voyager Reference Guide 
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6 From the File menu, choose Close to close the map. 

NOTE: Desire lines are temporary feature classes. If you attempt to save the map, 

Cube Base will ask if you want to make the layer permanent. Click Yes to save the 

layer in the map. You must enter a name for the layer. Click No to remove the layer 

from the saved map. 
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5 Exploring Reports 

This chapter contains a series of exercises that demonstrate how you can use reporting tools in 

Cube Base to simplify the analysis and presentation of results from travel forecasting models. These 

exercises use results from the Base scenario in the Discover Cube catalog. These exercises assume 

that you are familiar with Cube Base and the interface’s primary elements, Application Manager and 

Scenario Manager. For an introduction to Cube Base, see Chapter 4, “Exploring Cube Base and 

Cube Voyager”. 

 

The exercises in this chapter demonstrate: 

 

• Working with existing reports 

 

• Editing existing reports 

 

• Generating new reports 
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5.1 Working with existing reports 

Cube Base stores reports in a catalog. After you define a report, you can view the report for 

appropriate scenarios in your catalog, and you can use a report as the basis for defining a new 

report. You can access all reports from Scenario Manager, under the Data pane. 

 

 
Figure 46 Reports in Data Panel 

This section describes how to work with existing reports: 

 

• Examining reports 

 

• Generating reports for new scenarios 

 

• Working with multiple scenarios 
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Examining reports 
Whenever you run a scenario, Cube collects the data necessary to present a report. This exercise 

demonstrates how to examine a report. 

▪ To examine an existing report. 

1 If necessary, open the Discover Cube catalog. 

Refer to “To open the Discover Cube catalog and model” on page 13. 

2 If necessary, run the Base scenario. 

NOTE: If you already ran the Base scenario, such as during the exercises in Chapter 

4.2, “Running an existing scenario” you can skip this step. 

3 Open the Trip Length Frequencies report for the Base scenario. 

▪ Under Scenarios in Scenario Manager, select Base. 

▪ Under Data in Scenario Manager, click   to expand Reports. 

▪ Double-click Trip Length Frequencies. 

Cube opens the Trip Length Frequencies report. 

 

 
Figure 47 Trip Length Frequency Distribution for Work and School purposes – Base Scenario 
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4 Navigate between the three pages in the report. You can: 

▪ Navigate using the Home ribbon tab. Click the Next Page, Last Page, Previous 

Page, or First Page buttons, as appropriate. 

 
 

▪ Or, navigate using the keyboard. 

 
Key stroke Action 

  

HOME Scroll to the top of the current page. 

CTRL-HOME Move to the first page. 

END Scroll to the bottom of the current page. 

CTRL-END Move to the last page. 

PAGE UP Scroll the current page up. 

PAGE DOWN Scroll the current page down. 

Arrow keys Scroll a bit in the direction of the arrow. 
  

 

5 Close the report by clicking the close button for the tab. 

 

Generating reports for new scenarios 
Cube Base automatically generates predefined reports in your catalog for any new scenarios that 

you create. 

▪ To build a scenario and generate a report 

1 Create a new child scenario. 

▪ Under App in Scenario Manager, select Cube Voyager Demonstration Model. 

▪  Click Base and select Add Child on the Catalog ribbon tab. Or, right-click 

Base and select Add Child. 

▪ In the name space, enter: Scenario 1 

The Scenario Properties dialog box opens for the new scenario. 

▪ In Code, enter S1. 

You can append the scenario code to scenario-specific file names to help with 

file identification. 

▪ If desired, enter text describing the scenario in Description. 

▪ Click OK. 

▪ If necessary, double-click Scenario 1 to open the window for the scenario. 
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Figure 48 New Scenario Window 

2 Define the input files and parameters for the scenario.  

▪ Set Growth Factor for EE Trips to 1.5. 

3 Click Save to save the scenario. 

4 Run the scenario. 

▪ On the scenario window, click Run. 

Cube runs the application for Scenario 1. A Task Monitor window opens 

showing the progress of the run. When Cube completes the run, the Task Run 

Result dialog box opens. 

▪ Click OK to close the dialog box and the Task Monitor window. 

5 Examine the Trip Length Frequencies report. 

▪ Under Data in Scenario Manager, click  to expand Reports. 

▪ Double-click Trip Length Frequencies. 

Cube opens the Trip Length Frequencies report. 
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Figure 49 Trip Length Frequency Distribution for Work and School purposes – Scenario 1 Scenario 

Note that Cube generated the report for the new scenario automatically. You 

did not need to export any information or issue any additional commands. 

 

6 Close the report by clicking the close button for the tab. 

7 From the File menu, click Save and choose Catalog to save the new scenario in the 

catalog. 

 

Working with multiple scenarios 
Analysts usually apply a model many times to test different scenarios, sometimes hundreds of 

scenarios. Cube Base facilitates analysis of a report across multiple scenarios. This section contains 

exercises that demonstrate how you can compare multiple scenarios using two types of reports: 

• Single-scenario reports 

• Multiple-scenario reports 

 

Before completing these exercises, however, you must generate data for multiple scenarios. 

▪ To build additional scenarios 
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1 Build and run a child of Scenario 1, named Alternative A. 

▪ Click Scenario 1 and select Add Child on the Catalog ribbon tab. Or, right-click 

Scenario 1 and select Add Child. 

▪ In the name space, enter Alternative A. 

▪ In Code on the Scenario Properties dialog box, enter S1A1. 

▪ Click OK to close the Scenario Properties dialog box. 

▪ Double-click Alternative A to open the window for the scenario. 

▪ On the scenario window, set the Value of Time for Cars to 12 $/h. 

▪ Click Save. 

▪ Click Run to run the scenario. 

▪ Click OK to close the Task Run Result dialog box and the Task Monitor 

window. 

2 Build and run a child of the Base scenario, named Scenario 2. 

▪  Click Base and select Add Child on the Catalog ribbon tab, or, right-click 

Base and select Add Child (or right-click Scenario 1 and select Add Sibling). 

▪ In the name space, enter Scenario 2. 

▪ In Code on the Scenario Properties dialog box, enter S2. 

▪ Click OK to close the Scenario Properties dialog box. 

▪ Double-click Scenario 2 to open the window for the scenario. 

▪ On the scenario window, set the Growth Factor for EE Trips to 2. 

▪ Click Save. 

▪ Click Run to run the scenario. 

▪ Click OK to close the Task Run Result dialog box and the Task Monitor 

window. 

3 On the File menu, click Save and choose Catalog to save the scenarios in the catalog. 

 

Single-scenario reports 
Single-scenario reports present results from a single scenario. You can easily analyze multiple 

scenarios by comparing single-scenario reports. 

▪ To open copies of a report for a subset of scenarios 

1 If necessary, under Data in Scenario Manager, click  to expand Reports. 

2 Specify the desired subset of scenarios, Scenario 1 and Alternative A. 

▪ Under Data in Scenario Manager, right-click Trip Length Frequencies, and 

choose Select Scenarios. 

▪ Cube opens the Select Scenarios dialog box, which lists the scenarios defined 

in the catalog. 
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Figure 50 Select Scenarios Window for Reports 

▪ If necessary, click Clear All, to clear any scenarios listed in the Selected box. 

▪ If necessary, click  to expand the list of scenarios in the Scenarios box. 

▪ Select Scenario 1 and click Add With Children. 

Cube adds both Scenario 1 and Alternative A to the list in the Selected box. 

▪ Click OK to set the selection and close the window. 

3 Open the selected reports. 

▪ Under Data in Scenario Manager, right-click Trip Length Frequencies, point to 

View Report, and choose Selected Scenarios. 

 

For both selected scenarios (Scenario 1 and Alternative A), Cube display the 

Trip Length Frequencies report in separate windows. To view the reports, 

select the scenario then double-click Trip Length Frequencies. 

 

You can use the tabbed window interface to select the report window for a 

particular scenario. Or, if Cube is in “legacy” window mode, you may arrange 

the report windows by tiling or cascading them. For more on window 

management in Cube, see “Window Management” on page 8. 

4 Close each report window. 

 

Multiple-scenario reports 
Multiple-scenario reports present results from multiple scenarios in a single report. You can open 

these reports for a single scenario, for all scenarios, or for a selected set of scenarios. 

▪ To open a multiple-scenario report for a subset of scenarios. 

1 Specify the subset of scenarios, Scenario 1 and Scenario 2. 

▪ Under Data in Scenario Manager, expand Reports and Comparison Reports. 

▪ Right-click Compare Transit, and choose Select Scenarios. 

Cube opens the Select Scenarios dialog box, which lists the scenarios defined 

in the catalog. 



Discover Cube Tutorial  65 
 

▪ Click Clear All to clear the list in the Selected box. 

▪ If necessary, click  to expand the list of scenarios in the Scenarios box. 

▪ Select Scenario 1 and click Add. 

Cube adds Scenario 1 to the list in the Selected box. 

▪ Select Scenario 2 and click Add. 

Cube adds Scenario 2 to the list in the Selected box. 

▪ Click OK to set the selection and close the window. 

2 Open the report for the selected scenarios. 

 

Under Data in Scenario Manager, right-click Compare Transit, choose View Report, 

and select Selected Scenarios. 

 

Cube opens the Compare Transit report, which displays results from both selected 

scenarios in a single window. 

 

 
Figure 51 Compare Transit Report for Scenario 1 and Scenario 2 

3 Close the report window. 
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5.2 Editing existing reports 

You can easily edit the template for existing reports. This section contains a series of exercises that 

demonstrate how you can edit key features in reports: 

 

• General properties 

 

• Layout 

 

• Fonts 

 

• Data labels 

 

• Charts 

 

• Multiple scenario comparisons 

 

General properties 
All reports have general properties that describe the report and affect its display. This exercise 

demonstrates how you edit a report by changing one of its general properties. 

▪ To edit existing reports 

1 Open the Mode Choice report for the Base scenario. 

▪ Under Scenarios in Scenario Manager, select Base. 

▪ Under Data in Scenario Manager, click  to expand Reports. 

▪ Double-click Mode Choice. 

Cube opens the Mode Choice report for the Base scenario. 
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Figure 52 Mode Choice Report for the Base Scenario for Shop and School purposes 

2 Browse through all three pages of the report.  

Notice that the banner repeats on every page. 

3  Edit the report to show the banner just on the first page. 

▪  With the report open, select Edit Report on the Home ribbon tab. 

▪ Cube opens the Report Definition dialog box. 

▪ Select the General tab. 
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This tab contains several properties that define the report. 

 
Property Description 

Report File Name Name and location of file storing the report. 

Database Name Name of database file that provides the source data for the report. 

Acceptable file formats are: Database files (.dbf), Cube Voyager 

network file (.net), Cube Voyager matrix file (.mat). 

To generate different names by scenario, Cube incorporates a key 

name in the database name, such as {SCENARIO_DIR}. 

Scenarios Indicates whether the report can include results from multiple 

scenarios for side-by-side comparisons. There are two options: 

• Apply a Single Scenario to the Report - Select to show results from 

a single scenario in each report window. 

• Include Multiple Scenarios in the Report - Select to show results 

from multiple scenarios in a single report window for comparison. 

Scenario Name in 

Tables/Charts 

Indicates whether to display the scenario name using the long 

format, such as “Scenario1.AlternativeA,” or the short format, such 

as “Alternative A.” There are two options: 

• Show Short Scenario Name 

• Show Long Scenario Name 

Order Scenarios 

By 

For reports that show multiple scenarios, indicates the order that the 

report presents scenarios. There are two options: 

• Scenario Name 

• Scenario Tree Order 

Banner Name of file containing graphic that report displays at the top of the 

first page or at the top of each page. Select Repeat Banner on Each 

Page to display banner at the top of each page. 

Heading Title text that appears at the top of the first page or at the top of each 

page. Select Repeat Report Heading on Each Page to display title 

at the top of each page. 

 

▪ Unselect the Repeat Banner on Each Page check box. 

4 Click OK. 

Cube closes the dialog box and updates the report to reflect the new settings, 

displaying the banner on just the first page. 
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Layout 
You can configure a report’s page size and orientation, and the information that appears in the 

header and footer. This exercise demonstrates how you can edit the information in a header and 

footer. 

▪ To edit a report’s header and footer layout 

1 Open the Mode Choice report for the Base scenario. 

2  With the report open, select Edit Report on the Home ribbon tab. 

Cube opens the Report Definition dialog box. 

3 Select the Layout tab. 

 
 

This tab contains two sections with properties that define the report’s page size and 

header and footer information. 

 
Section Description 

  

Paper Size and Specify the report’s orientation and paper size. 

Orientation The default setting configures reports to use the 
 

 paper size and orientation of your computer’s 

 current printer. However, configuring a setting 

 allows you to control the presentation regardless 

 of the selected printer. 

Header and Footer Specify what appears in the report’s headers and 

 footers. 

 The default setting shows the report’s title in the 

 center of the header. You can configure the page 

 number, date, or title to appear at the left, center, 

 or right side of the header or footer. 
  

 

4 Configure the date to appear on the left side of the header and the page number to 

appear on the right side of the footer. 

▪ Under Header, in Left, select Date. 

▪ Under Footer, in Right, select Page Number. 
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5 Configure the format for the date and page number. 

▪ In Page Number Format, select n/N. 

▪ In Date Format, select Long (dd MMMM yyyy). 

6 Click OK. 

Cube closes the dialog box and updates the report to reflect the new settings, 

displaying the header and footer on all three pages. 

 

Fonts 
You can configure which fonts a report uses for different elements. This exercise demonstrates how 

to edit fonts displayed in the header and footer. 

▪ To edit fonts displayed in the header and footer 

1 Open the Mode Choice report for the Base scenario. 

2  With the report open, select Edit Report on the Home ribbon tab. 

Cube opens the Report Definition dialog box. 

3 Select the Fonts tab. 

 
 

From this tab, you can set the font for different categories of text in the report. You 

can set the font by category or globally for all categories. You can also reset all 

categories to the value in the default category or to the values currently used for new 

reports. 

4 Set the font size in the header and footer to 9 points. 

▪ Under Category, select Page Header, and click Select Font. Cube opens the 

Font dialog box. 

▪ In the Size list, select 9 and click OK. 

▪ Repeat the steps above for the Page Footer category. 

▪ Click OK to accept the settings and close the Report Definition dialog box. 

Cube updates the report to reflect the new settings, displaying the smaller font 

in the header and footer on all three pages. 
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Data labels 
Labels describe data elements in a report. You configure aliases for database fields. These aliases 

are the labels you see in the report. This exercise demonstrates how to edit the data labels in a 

report. 

▪ To edit a report’s data labels 

1 Open the Mode Choice report for the Base scenario. 

2  With the report open, select Edit Report on the Home ribbon tab. 

Cube opens the Report Definition dialog box. 

3 Select the Fields tab. 

 
 

From this tab, you can set the aliases that the report displays for database fields. For 

example, aliases are often visible in the column headers of a table. Aliases might be 

shorter or more descriptive than the actual field names. 

4 Change the “Car Pool” label to “Carpool.” 

▪ In Available Fields, select V2 (Car Pool) and click Alias. Cube updates the 

dialog box to allow alias entry. 
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▪ In Report Alias Name, enter Carpool. 

▪ Click OK. 

Cube returns to the view version of the Available Fields list. 

▪ Repeat the steps above for the other fields currently labeled “Car Pool”: V7, 

V12, V17, and V22. 

NOTE: When you specify the report alias name, Cube will warn you that the 

alias is already in use. Click Yes to use it anyway. 

5 Click OK to accept the settings and close the Report Definition dialog box. 

Cube updates the report to reflect the new settings, displaying the correct label for 

carpools on all three pages. 

 

Charts 
Charts provide a graphical view of results, allowing analysts to quickly compare the scale of values. 

Charts are often more attractive than a table of numbers. You can use Cube Base to produce pie 

charts, bar charts, or scatter diagrams. This exercise demonstrates how you might edit the format of 

an existing chart. 

▪ To edit an existing chart 

1 Open the Mode Choice report for the Base scenario. 

2  With the report open, select Edit Report on the Home ribbon tab. 

The Report Definition dialog box opens. 

3 Select the Tables/Charts tab. 
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From this tab, you can add new tables or charts to a report, or you can edit, delete, 

or reorder existing tables and charts. 

4 Under Report Contents, double-click Work Mode Choice. 

Cube opens the Report Chart dialog box, where you can edit the Work Mode Choice 

chart. 

 
 

This dialog box contains several tabs where you configure the information presented 

and the display format: 

▪ Chart — Use the Chart tab to configure the name identifying the chart, the 

title of the chart on the report, the type of chart, and how the report presents 

the chart for multiple scenarios. 
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▪ Fields — Use the Fields tab to configure which database fields the chart 

presents and what statistics the report computes for each field. If desired, 

you can group data by field attributes and you can filter data. 

▪ Layout — Use the Layout tab to configure the chart’s dimensions and 

position, as well as the format and dimensions of various elements. 

▪ Fonts — Use the Fonts tab to configure the fonts used in the chart’s title, 

legend, and labels. 

▪ Colors — Use the Colors tab to configure the colors presented for different 

slices in pie charts or different columns in bar charts. 

5 Configure the chart as a 3D chart without a legend. 

▪ Select the Layout tab. 

▪ Select the Show in 3D check box. 

▪ Select the Show Legend check box. 

6 Click OK to close the Report Chart dialog box. 

7 Click OK to close the Report Definition dialog box. 

Cube updates the report to reflect the new settings, displaying a 3D version of the 

Work Mode Shares chart, without a legend. 

 

Multiple scenario comparisons 
You can configure a report to present results from multiple scenarios. This exercise demonstrates 

how to edit an existing report to ensure that the report presents results from multiple scenarios in a 

helpful way. 

▪ To edit an existing report to present results from multiple scenarios 

1 Open the Mode Choice report for the Base scenario. 

2 Verify that the configuration supports multiple reports. 

▪  With the report open, select Edit Report on the Home ribbon 

tab. 

The Report Definition dialog box opens. 

▪ Select the General tab. 

▪ Verify that two options are selected: 

• Include Multiple Scenarios in the Report. 

• Scenario Tree Order 
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▪ Click OK. 

3 Close the opened Mode Choice report. 

4 Select the scenarios to open for the Mode Choice report: Base and Scenario 1. 

▪ Under Data in Scenario Manager, right-click Mode Choice, and choose Select 

Scenarios. 

NOTE: Mode Choice is under the Reports folder. 

Cube opens the Select Scenarios dialog box, which lists the scenarios defined 

in the catalog. 

▪ Click Clear All to clear the list in the Selected box. 

▪ If necessary, click  to expand the list of scenarios in the Scenarios box. 

▪ Select Base and click Add. 

Cube adds Base to the list in the Selected box. 

▪ Select Scenario 1 and click Add. 

Cube adds Scenario 1 to the list in the Selected box. 

▪ Click OK to set the selection and close the window. 

5 Open the report for the selected scenarios. 

Under Data in Scenario Manager, right-click Mode Choice, point to View Report, and 

choose Selected Scenarios. 

Cube opens the Mode Choice report, which displays results from both selected 

scenarios in a single window. 

The report contains more pages, reflecting the additional information presented. 

However, each chart has the same title; you cannot differentiate between scenarios. 

6 Configure the report to include the scenario name in the chart title. 

▪  With the Mode Choice report open, select Edit Report on the 

Home ribbon tab. 

The Report Definition dialog box opens. 

▪ Select the Tables/Chart tab. 

▪ In the Reports Contents item list, double-click Work Mode Choice. 

The Report Chart dialog box opens. 

▪ Select the Chart tab. 

▪ Click the browse button next to Chart Title. 
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Cube opens the Build Text with Catalog Keys dialog box, which enables you 

to construct a chart title using keys defined in the catalog. 

▪ Clear the Show Catalog Keys check box to limit the displayed keys to system 

keys. 

 
 

▪ Double-click Scenario_ShortName to add the key to the chart title’s text. 

▪ Insert spaces and a hyphen in the text: Work Mode Shares - 

{Scenario_ShortName} 

▪ Click OK to accept the text. 

▪ Click OK to close the Report Chart dialog box. 

▪ Repeat the above steps for the other charts included in the report contents: 

• Shop Mode Choice 

• School Mode Shares 

• Other Mode Shares 

• Non Home Base Shares 

▪ Click OK to close the Report Definition dialog box 

Cube updates the report to reflect the new settings, displaying the scenario 

name in the chart title. 

7 Save your changes. 

On the File menu, choose Save > Catalog. 
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5.3 Generating new reports 

Reports can accept several types of input: 

 

• Database files (.dbf files) 

• Cube Voyager network files (.net files) 

• Cube Voyager matrix files (.mat files) 

 

This section contains exercises that show how to generate new reports by: 

 

• Creating reports from existing reports 

• Creating reports from scratch 

 

Creating reports from existing reports 
Copying existing reports allows you to easily create a new report from the same database file as an 

existing report. 

▪ To create a new report by copying an existing report 

1 Open the Person Trips report for the Base scenario. 

▪ Under Scenarios in Scenario Manager, select Base. 

▪ Under Data in Scenario Manager, click  to expand Reports. 

▪ Double-click Trip Generation. 

The Trip Generation report for the Base scenario opens. 

2 Save the report as Trip Generation New. 

▪ On the File menu, choose Save As. 

▪ In the File name box, enter trip generation new.rep. 

▪ Click Save. 

3 Verify that the catalog is opened in developer mode. 

▪  Choose the Scenario tab in the Cube Ribbon, and click the caption button 

on the Catalog group (small grey arrow). 

The Catalog Properties dialog box opens. 

▪ Select the Model User tab. 

▪ Under Model User, select Model Developer. 

 
▪ Click OK to close the Catalog Properties dialog box. 

4 Add the new report to the catalog. 
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▪ Under Data in Scenario Manager, right-click Reports and choose Add Existing 

Report. 

▪ Next to Data Name, click Browse. 

▪ In the Open dialog box, select trip generation new.rep and click Open. 

▪ In Description, enter the name of the report that will appear in Scenario 

Manager: Trip Generation New. 

 
▪ Click OK. 

Cube adds the report under Reports in Scenario Manager. 

5 Edit the report to present the desired information. 

See “Editing existing reports” on page 66 for information on how you can edit existing 

reports. 

 

Creating reports from scratch 
You can create new reports directly from output files shown in Scenario Manager. 

▪ To create a new report 

1 In the Data pane, right-click Reports and select Create Report. The Report Definition 

dialog box opens. 

2 On the General tab, enter general properties that describe the report. 

▪ In Report File Name, enter the file where Cube stores the report definition. 

• Click the browse button . 

• Navigate to the C:\Cubetown\Model\Reports directory. 

• In the File name box, type: HighwaySummary.rep. 

• Click Save. 

▪ In Report Name, enter the name that identifies the report: Loaded Network 

– Summary. 

▪ In Database Name, click Select. 

• Click Browse Windows Folders and navigate to C:\Cubetown\Base. 

Choose Results.mdb. Click Yes on replacing the directory name with 

{SCENARIO_DIR}. 

• Under Table Name, choose CombinedOutputs_Link. 

• Click OK. 

▪ The Report Definition dialog should now look like: 
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3 Choose the Fields tab. 

Enter labels for the database fields that the report will show. 

 
Database field Label 

  

V_1 Total Flows 

VC_1 Volume/Capacity 

CSPD_1 Congested Speed 
  

 

To enter a label: 

▪ Under Available Fields, select a database field and click Alias. 

▪ In Report Alias Name, enter the desired label. 

▪ Click OK. 

4 On the Tables/Charts tab, specify the report’s content. 

▪ Click Add Chart. 

The Report Chart dialog box opens. 
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▪ On the Chart tab, enter properties that define the chart. 

• In Chart Name, enter Average Congested Speed. 

• In Chart Title, enter Average Congested Speed - 

{Scenario_ShortName}. 

NOTE: Select the browse button to select the field name from a list of 

available keys. 

• In Chart Type, choose Bar. 

 

▪ On the Fields tab, specify which values to display in the chart. 

• Under Report Fields, select CSPD_1(Congested Speed) and click the 

arrow button  to move the field under Values to Compare. 

• Under Function, select Average as the computation for congested 

speed values. 

• Select the Group values within the Chart by a Data Attribute check 

box. 

Cube adds the Group Values By box to the dialog box.  

• Under Report Fields, select FUNC_CLASS and click the arrow button 

 to move the field under Group Values By. 

The chart will group data with different values in the FUNC_CLASS 

field. 

 
▪ Select the Layout tab. 

Increase Chart Width to 180mm. 

▪ Click OK to close the Report Chart dialog box. 

You have defined sufficient data to view a draft version of the new report. 

5 Click OK to close the Report Definition dialog box. 

Cube adds the new report to the Reports folder under Data in Scenario Manager. 

6 Under Data in Scenario Manager, click  to expand Reports. 

7 Double-click Loaded Network - Summary to view the report. The report opens. 
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8 If desired, edit the report to make it more attractive and robust. 

Using the exercises in “Editing existing reports” on page 66 as a guide, you might: 

▪ Add a banner 

▪ Display the results in 3D 

▪ Show results from multiple scenarios in a single report 

9 Set the catalog to applier mode. 

▪  Choose the Catalog tab, and click the caption button on the Catalog group. 

The Catalog Properties dialog box opens. 

▪ Select the Model User tab. 

▪ Under Model User, select Model Developer. 

▪ Click OK to close the Catalog Properties dialog box. 

10 Save the catalog and exit Cube. 

▪ On the File menu, choose Save > Catalog. 

▪ On the File menu, choose Exit Cube. 

▪ At the prompt, click Yes to close all windows and exit. 
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6 Exploring Cube Cargo 

This chapter contains a series of exercises that demonstrate how you can use Cube Cargo to 

forecast commodity and truck flows. These exercises use the model in the Discover Cube catalog, 

found with the Cubetown data that you installed. These exercises assume that you are familiar with 

Cube Base and the interface’s primary elements, Application Manager and Scenario Manager. For 

an introduction to Cube Base, see Chapter 4, “Exploring Cube Base and Cube Voyager”. 

 

The exercises in this chapter demonstrate: 

 

• Cubetown Cargo model 

 

• Forecasting demand for proposed rail service 

 

• Forecasting impact of rail pricing 
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6.1 Cubetown Cargo model 

The exercises in this chapter use the Cube Cargo Demonstration Model, a cargo model for 

Cubetown. In this section, we will become familiar with the model, and run the Base scenario to 

estimate the commodity levels by mode and the truck matrices for the base conditions. 

▪ To become familiar with the Cubetown cargo model 

1 If necessary, open the Discover Cube catalog. 

Refer to “To open the Discover Cube catalog and model” on page 13. 

2 Under App in Scenario Manager, double-click Cube Cargo Demonstration Model to 

open the Cubetown cargo model. 

Application Manager opens the Cube Cargo Demonstration Model. 

 

 
Figure 53 Cube Cargo Demonstration Model in Application Manager 

The yellow/green boxes represent steps in the model, the blue boxes show inputs to 

each step, and the green boxes show the outputs. Lines represents the links between 

outputs from one step and inputs to the next step. 

 

This model has three steps: 

▪ Compute network costs and times by mode 

▪ Estimate zone-to-zone commodity and truck matrices 

▪ Compute peak-hour trucks 

 

3 Open the Base scenario.  

Under Scenarios in Scenario Manager, double-click Base. 

Cube opens the scenario window for the Base scenario. 

 



Discover Cube Tutorial  84 
 

 
Figure 54 Cube Cargo Demonstration Model inputs in Scenario Panel for the Base Scenario 

 

4 Click Edit next to the field for entering the Roadway network. 

Cube opens the GIS window, which shows a map of the highway network and the rail 

services connecting major points. 

 

 
Figure 55 Cube Cargo Demonstration Model input Roadway Network for the Base Scenario 
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You can use Cube Cargo models to study both long-distance and local freight 

movement. Creating a large-scale study area allows us to properly study the amount 

of goods passing through, originating from, or terminating in Cubetown by various 

modes. 

 

In addition to rail and highway services, the study area has river services. 

 

5  From the Home ribbon tab, click Add Data and choose Geodatabase Data. 

Geodatabase Browser opens. Browse to C:\Cubetown\Inputs and select 

Cubetown.mdb. 

6 Select CARGORIVER (PT) in the right-hand pane, and click Open, to add the river 

transit layer to the map. 

7 Cube shows the entire study area, including the river services. 

 

 
Figure 56 Cube Cargo Demonstration Model input Roadway Network and Cargo River for the Base Scenario 

The mode choice for freight is likely to impact the truck flow passing through the study 

area of Cubetown. 

8 Close the GIS window. 

9 At the prompt to save the map document, click No. 

10 On the scenario window, click Run to run the Base scenario. 

The Task Monitor window opens, showing the progress of the run. When complete, 

a Task Run Result dialog box opens. 

11 Click OK.  
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6.2 Forecasting demand for proposed rail service 

Cubetown presently serves as the region’s rail hub. Shippers send freight from all areas for transfer 

at Cubetown. The rail service operators want to consider the market for new, direct north-south rail 

freight service. We will use the Cube Cargo model to help them estimate the demand for this 

proposed service. 

 

There are two parts to this exercise: 

• Developing a scenario for proposed rail service 

• Evaluating results 

 

Developing a scenario for proposed rail service 
To estimate the demand for the proposed rail service, we need a new scenario with a modified rail 

input, which represents the proposed service. 

▪ To develop a scenario for proposed rail service 

1 Under Scenario in Scenario Manager, right-click Base and choose Add Child. 

2 In the name space, enter: New Rail 

A Scenario Properties dialog box opens. Enter the Scenario Code: NR, and, if desired, 

enter text describing the scenario in the Description box. 

3 Click OK. 

4 Double click New Rail to open its window. By default, the new scenario uses all the 

values from its parent scenario, the Base scenario. We will change the input for the 

rail network. 

5 Click Browse next to the field for entering rail lines. 

A file browser dialog opens to specify the rail lines input. 

6 In the C:\Cubetown\Inputs directory, select cubetown.mdb. Its contents will display in 

the right-hand pane. 

7 Select CargoFutureRail and click Ok. 

Cube updates the input in the scenario window. 

8 Select “Compare this child scenario with parent”, checking the box. This will allow to 

create additional necessary outputs for scenarios comparison. 
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Figure 57 Cube Cargo Demonstration Model inputs in Scenario Panel for the New Rail Scenario 

This rail file introduces a new rail service (Express)) from the southern portion of the 

study area to the northern portion, without stopping in Cubetown. 

 
Figure 58 Cube Cargo Demonstration Model FutureRail for the New Rail Scenario 

9 Click Save to save the scenario’s configuration. 

10 Click Run to run the scenario. 

The Task Monitor window opens, showing the progress of the run. When complete, 

the Task Run Result dialog box opens. 

11 Click OK. 
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Evaluating results 
Cube Cargo computes a variety of statistics and results, including detailed matrices of commodity 

and truck flows. To evaluate the New Rail scenario, we want to measure the reduction in truck flows 

and the increase in rail tons. 

 

The model produces two output files useful for our analysis: 

• Truck Change — A matrix showing the reduction in annual truck flows 

• Commodity Change — A matrix showing the change in tons of commodities transported by 

mode per year 

▪ To evaluate results, with the New Rail scenario selected under the scenarios list 

1 Under Data in Scenario Manager, expand Outputs and expand Cargo. 

2 Double-click Truck Change. 

Cube opens the truck change matrix, which shows the change in truck flows between 

zones. 

 

 
Figure 59 Truck Change – New Rail - Base 

3 In Scenario Manager, double-click Commodity Change. 

Cube opens the commodity change matrix, which shows the change in commodities 

carried between zones by mode. 

4 Click the 2 railchange tab to see the results for rail mode. 
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Figure 60 Commodity Change – New Rail - Base 

5 Close the results windows when done. 
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Forecasting impact of rail pricing 
The Cube Cargo model evaluates changes in costs in addition to changes in level of service. In this 

exercise, we will evaluate how increasing rail costs by 10% impacts truck traffic. 

 

▪ To forecast the impact of increased rail costs 

1 Under Scenario in Scenario Manager, right-click Base and choose Add Child. 

2 In the name space, enter: Rail Increase 

A Scenario Properties dialog box opens. Enter the Scenario Code: RI, and, if desired, 

enter text describing the scenario in the Description box. 

3 Click OK. 

4 Double-click Rail Increase to open its scenario window. By default, the new scenario 

uses all the values from its parent scenario, the Base scenario. We will change the 

rail costs. 

5 Under Please select the percentage change in rail transport costs, select 10. 

 
6 Select “Compare this child scenario with parent”, checking the box. This will allow to 

create additional necessary outputs for scenarios comparison. 

7 Click Save to save the configuration for the Rail Increase scenario. 

8 Click Run to run the scenario. 

The Task Monitor wRail indow opens, showing the progress of the run. When 

complete, the Task Run Result dialog box opens. 

9 Click OK. 

10 Under Data in Scenario Manager, expand Outputs and expand Cargo. 

11 Double-click Truck Change. 

Cube opens the truck change matrix. 
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Figure 61 Truck Change – Rail Increase - Base 

12 Double-click Commodity Change. 

Cube opens the commodity change matrix. The 1 truckchange tab shows the results 

for truck mode. 

 

 
Figure 62 Commodity Change – Rail Increase - Base 

13 Click the 2 railchange tab to see the results for rail mode. 

The results show that increasing rail costs by 10 percent decreases rail shipments by 

more than 39,500, tons and increases truck shipments by nearly 33,900 tons. 

14 Close the results windows when done.   
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7 Exploring Cube Land 

These exercises assume that you are familiar with Cube Base and the interface’s primary elements, 

Application Manager and Scenario Manager. For an introduction to Cube Base, see Chapter 4, 

“Exploring Cube Base and Cube Voyager”. 

 

Cube Land is a Land Use forecasting model based on the bid-rent theory. Using Cube Land, you 

can forecast the locations of households and businesses (firms/employment) to real-estates within 

the zones of a study area, at the equilibrium condition (every agent is allocated to a supply unit). 

You can also test scenarios, to see how these locations might change with various transportation 

and policy assumptions. Cube Land also models real estate development and rent values, and can 

be used to study the effects of land use regulations. 

 

The Cube Land forecasting process is represented by using an aggregate approach: dealing with 

zones, demand (households/firms) clusters and supply (real estates) groups, whilst Cube Land 

models can be estimated by using disaggregated as well as aggregated data. 

 

Cube Land integrated with Cube Voyager allows you to model the interaction between real estate 

markets and transportation systems (Land Use Transport Interaction – LUTI) .  

 

This document introduces you to Cube Land and demonstrates some basic exercises using Cube 

Land with the Cubetown demonstration model. Topics include: 

 

• Opening and examining the LUTI model 

 

• Allocating socio-economic totals 

 

• Studying transportation projects 
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7.1 Opening and Examining the LUTI Model 

▪ To open and examine the LUTI model. 

1 If necessary, open the Discover Cube catalog. 

Refer to “To open the Discover Cube catalog and model” on page 13 – Cube opens 

the Discover Cube catalog in Scenario Manager. The catalog shows the scenarios, 

data, and applications used with the Cubetown demonstration models. 

2 Under Applications in Scenario Manager, double-click Land Use-Transport 

Interaction Model to open the LUTI model example application. 

 
Cube opens the LUTI Model in Application Manager (AM). 

 

 
Figure 63 LUTI Model in Cube – Application Manager 

The yellow and blue large boxes represent steps in the model outside and inside the 

feedback loop respectively. The dark green box represents the Cube Land (Land Use) 

step. The light blue boxes show inputs to each step, and the green boxes show the 

outputs. Lines represent the links between outputs from one step and inputs to the 
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next step. You can see the input and output data for the Cube Land Demonstration 

Model, as well as the other modelling steps. 

 

In the Cubetown demonstration model, Cube Land is integrated with a typical four-step Voyager 

travel demand model, with the following steps:  

• Network processing – prepares input networks and initial travel cost matrices 

• Feedback loop – copies and replaces trip and travel cost matrices with their current values 

from the transportation model outputs 

• Cube Land Demonstration Model – forecasts household and firm agent locations based 

upon current transportation model outputs and zonal variables. Steps 3 through 7 are 

included in the feedback loop 

• Trip Generation – forecasts trip productions and attractions by zone based upon the 

household and firm locations output from Cube Land 

• Trip Distribution – applies a gravity model to forecast person-trips by purpose 

• Mode Choice – applies a logit choice model to forecast person-trips by mode 

• Assignment – converts person-trips to peak hour vehicle-trips and performs highway as well 

as public transit network assignment with congested costs 

• Output processing – create the final outputs in terms of loaded PT and HW networks and 

undertake scenarios comparison 

 

Cube Land is implemented within the Cube Land Demonstration Model sub-application (Figure 64). 

 

3 Double-click on the Cube Land Demonstration Model program group box to open 

the Cubetown Cube Land model. 

 

 
Figure 64 Cube Land Demonstration Model step 

Pre- and post-processing Cube Voyager scripts translate the inputs and outputs for the Cube Land 

program: 

• Pre-Processing – use Cube Voyager to convert and format Cube Land input data: 

o Zone-to-zone transportation network time, distance and cost matrices, or “skims” 
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o Aggregate characteristics and total counts for each type of location decision-maker, 

or “agent”. Examples of agent types include medium-income three-person 

households and factories with 100 employees on average 

o Land use zoning and regulations, such as the total area available in each zone for 

designated land uses, and the typical characteristics of real estate options by type, 

as well as prohibited land uses and subsidies by zone 

o Initial characteristics of zones, such as the share of developable land used by type 

• Land Model – run the Cube Land program 

• Post-Processing – use Cube Voyager to convert and format Cube Land outputs 

 

The Cube Land program (inside the Land Model sub-application) has: 

• 4 configuration files (Control File, Context File, Param File and Endogvar File): defining the 

input files and their format, along with the simulation parameters that validate the input files 

• 22 input files: specifying inputs that the simulation model requires (parameters, consumer 

attributes, zone information). Cube Land input files are grouped into four sets: 

o [1] Input files that modify the prediction scenario: inputs that generate changes 

in the city that will lead to changes in real estate market 

o [2] Input files that define market attributes as attributes of agents, real estates, 

zones and definition of submarkets. Cube Land allows the inclusion of a large 

number of variables representing the most relevant attributes of consumers (socio-

economic characteristics), real estate (property types), and the locations/zones 

(neighbourhoods). These are the design elements of the simulation 

o [3] Input files that define the inclusion/exclusion of agents/real estates for every 

location. 

o [4] Input files that define the Cube Land models mathematical formulation: The 

files of demand model, supply model, rent model, cost model, cost adjustment, rent 

adjustment, and bid adjustment are part of this set. The files belonging to this subset 

contains all the calibration parameters that are obtained during the model estimation 

and calibration processes 
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Figure 65 Cube Land program with colours highlighting the 4 input files sets 

Some of the Cube Land inputs are generated by using Cube Voyager to interpret and re-format travel 

demand model and GIS files in the structures expected by Cube Land. 

 

Five output files are provided by the Cube Land program, other outputs can be obtained by post-

processing: 

• Locations = how many agents (households and businesses) are located at equilibrium by 

agent category h, real estate type v and zone i 

• Rents = relative rents for each type of property v located in zone i. Note: these are relative 

rents to a specific vi but absolute monetary values 

• Endogenous Var = zonal endogenous attributes at equilibrium – these are dependent 

variables whose value is modified during the model run due to changes in Land Use attributes 

(dependent on agent location) – e.g. percentage of residential/non-residential area in a zone, 

average income level in a zone, etc. 

• Bids = bid for each consumer h (households and firms) for each type of real estate v and 

zone i, these represent the willingness of each agent to pay for each real estate option in 

each zone 

• Supply = occupied supply (such as dwelling units and commercial units) of real estate type 

v in each zone i, reached at equilibrium 

 

Some of the Cube Land outputs are processed by Cube Voyager to summarize zonal values and 

write attribute tables to shapefiles that can be viewed in the GIS Window. 

 

Even if the Cube Land Demonstration model shown here is integrated with a typical four-step Cube 

Voyager travel demand model, Cube Land can be integrated with any type of model system, 

including activity-based models and other software. In addition, if you have already developed all the 

necessary input files, you could run Cube Land by itself, without feedback to a travel demand model. 
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7.2 Allocating Socio-Economic Totals 

This exercise shows how you might use Cube Land to allocate revised socio-economic control totals 

for a study area to transportation analysis zones for further analysis. 

▪ To run a Cube Land scenario. 

1 Create the “Growth” scenario. 

▪ Under Scenario in Scenario Manager, right-click on Base, and select Add 

Child. 

 
▪ Name the new scenario “Growth” and enter a description in the Scenario 

Properties dialog. Cube opens the Scenario Editing window for the Growth 

scenario (click Next… to visualize both pages of scenario inputs). 

 

 
Figure 66 Scenario Editing Window for the Growth Scenario 

2 Change the Growth Factor for EE Trips field to 1.5. 

3 Edit the control totals. 

▪ Click Edit… next to the line for Socio-economic control totals (agent attributes 

and control totals). 

▪ Cube recognizes that the file is shared with the parent scenario and asks if 

you want to make a copy of the file for the current scenario. Click the Yes 

button. 
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▪ Name the file SE_GROWTH.dbf and store it in the 

C:\Cubetown\Inputs\LAND_Inputs folder. Click OK, when asked to copy the 

scenario file from the Parent Scenario, Cube opens the SE_GROWTH.dbf file. 

 

 
 

This table contains a row for each household or firm type in the model 

(agents), and columns corresponding to the attributes of the household or firm 

type. In particular, the required column NAGENT contains the number of 

members of each household or firm category, i.e. the total number of decision-

making “agents” to be located within the model. 

 

▪ Go to the Database menu and select Compute… to apply a simple recursive 

growth rate calculation to the columns of the table. Type 

“NAGENT=NAGENT*1.02^20” in the Equations field, then click Compute. 

 

 
 

You can also modify the table cells directly in the Cube table editor window. 

In real-world models, this table might be generated by regional 

macroeconomic and demographic forecasting models, such as a spatial input-

output analysis package. 

 

4 Close the table. 

▪ Click Save, then Run in the Scenario Editing window. 

▪ The Task Monitor window opens, showing the progress of the run. When 

complete, a Task Run Result dialog box opens. 

▪ Click OK. 
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5 View the model outputs. 

▪ Under Data in Scenario Manager, expand the folder named Outputs, and the 

sub-folder named Land. 

 

 
 

▪ Double-click on Households and Jobs. 

▪ Cube opens the ZO_HHJOBS.SHP file, which is based upon the output of the 

land-use model. 

▪ From the Cube menu, select Analysis, then point to Node/Point Chart… (if this 

button is greyed out, select the ZZ_HHJOBS.SHP layer within the TOC first) 

▪ Apply the Boundary Layer Node Chart settings shown below, and click OK. 

 
 

Cube displays a pie chart map showing the location and type of jobs in the 

study area as forecast by the Cube Land model. Larger circles correspond to 

zones with more employment, and the size of the slices in each circle 

represents the relative share of the corresponding type of employment. 
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Figure 67 Pie chart map showing the location and type of jobs in the study area – Growth Scenario 

 

You could also create a bar chart showing the distribution of households by 

size category (HH1 through HH4), or overlay other data, such as 

transportation networks, and save an ArcGIS map document to share with 

others. Close the map when finished. 
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7.3 Studying Transportation Projects 

When Cube Land is integrated with a travel demand model, you can use the integrated model to 

study the possible land-use effects of transportation projects. This exercise shows how you might 

use Cube Land to study the effects of a roadway project first and of a transit project second. 

 

▪ To analyze the land-use effects of a roadway project. 

1 Create the new scenario. 

▪ Right-click on the Growth scenario and select Add Child. 

▪ Name the new scenario Roadways and enter a description in the Scenario 

Properties dialog. 

 

2 Change the Highway network input path to the Build Road network, stored at 

“C:\Cubetown\Inputs\cubetown.mdb\Build”. 

3 Select Compare this child scenario with parent by checking the box (click “Net…” if 

needed) 

 

Note: This exercise assumes that you have already edited the Build network to 

include the new roadway project. For more information, see Chapter 4 “Exploring 

Cube Base and Cube Voyager” of this tutorial. 

 

4 Run the model. 

▪ Click Save, then Run in the Scenario Editing window. 

The Task Monitor window opens, showing the progress of the run. When 

complete, a Task Run Result dialog box opens. 

▪ Click OK. 

▪ Click Close to hide the Scenario Editing window. 

 

5 View the outputs. 

▪ Under Data in Scenario Manager, expand Outputs, then Land. Double-click 

on Land Use Comparison to open the ZD_LAND.SHP file, which is a shapefile 

containing differences between this scenario (Roadways) and its parent 

(Growth) scenario. 

 

 
 

▪ Go to the Analysis menu and select Thematic Map… (if this button is greyed 

out, select the ZZ_HHJOBS.SHP layer within the TOC first) 
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▪ In the Expression field, type HOUSEHOLDS (or right-click on the empty box 

to have the list of fields values).  

▪ Click on the leftmost Color rectangle and choose a red color, then click on the 

rightmost Color rectangle and choose a blue color.  

▪ Click Color On to apply the thematic map settings as shown below. 

 

 
 

Cube displays a thematic map showing the effects of roadway construction on 

household location. Zones that gain households are shown in blue, while 

zones that lose households are shown in red. Purple zones experience no 

change (Figure 68). 

 

The impacts of this roadway project shows household relocating towards outer 

zones due to the improved accessibility. 
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Figure 68 Thematic map showing the re-location of Households – Growth.Roadways Scenario 

 

▪ To analyze the land-use effects of a transit project. 

1 Create the new scenario. 

▪ Right-click on the Growth scenario and select Add Child. 

▪ Name the new scenario Transit and enter a description in the Scenario 

Properties dialog. 

 

2 Change the Public transit lines input path to the Headway PT network, stored at 

“C:\Cubetown\Inputs\cubetown.mdb\Headway”. 

 

Note: This exercise assumes that you have already edited the Headway PT network 

to show increased transit service. For more information, see Chapter 4 “Exploring 

Cube Base and Cube Voyager” of this tutorial. 

 

3 Run the model. 

▪ Click Save, then Run in the Scenario Editing window. 



Discover Cube Tutorial  104 
 

▪ The Task Monitor window opens, showing the progress of the run. When 

complete, a Task Run Result dialog box opens. 

▪ Click OK. 

▪ Click Close to hide the Scenario Editing window. 

 

4 View the outputs by repeating step 4 of the previous exercise to set up a thematic 

comparison map showing changes in household location. 

 

Any type of project that can be represented in a travel model can be analyzed using an integrated 

land use / transportation model. The sensitivity of household and firm location to transportation 

projects in Cube Land will depend upon the form of the accessibility and attractiveness measures 

used to represent the level of transportation service in each zone by agent and mode, as well as the 

estimated location bid functions coefficients for these variables. 

 

You can also represent a wide variety of land use regulations using Cube Land, including: 

 

• Zoning restrictions on the amount of land available for certain uses 

 

• Development constraints and prohibitions on land uses in selected zones 

 

• Fixed (policy-driven) development and institutional uses 

 

• Taxes and subsidies for specific types of land use and real estate development 

 

For more information on these topics, please see the Cube Land Reference Guide. 
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8 Discover Activity-Based Modeling 

Using Cube Voyager 

Important Note: * the ABM application uses the Trucks Trips table coming from the Cube Cargo 

Demonstration Model ({SCENARIO_DIR}\FORECASTEDTRUCK.MAT), therefore the Cube Cargo 

Demonstartion Model for the selected scenario needs to run before running the ABM model, see 

Chapter 6 “Exploring Cube Cargo”. * 

 

 

Cube Voyager is a flexible scripting language that you can use to build any type of transportation 

model. In addition to convenient functions for efficiently processing the square zone-to-zone matrices 

commonly found in traditional trip-based, or “four-step” travel demand models, Cube Voyager 

includes record processing and database manipulation commands that can be used to construct 

Tour-Based and Activity-Based Models (ABM).  

 

This document describes the simplified activity-based model example in Cubetown. Topics include: 

 

• Overview of structure and data 

 

• Opening and examining the activity-based model 

 

• Running the activity-based model 

 

These exercises assume that you are familiar with Cube Base and the interface’s primary elements, 

Application Manager and Scenario Manager. For an introduction to Cube Base, see Chapter 4, 

“Exploring Cube Base and Cube Voyager”. 
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8.1 Overview of structure and data 

Traditional travel demand forecasting models are usually “trip-based”, meaning that they use a 

hypothetical trip from an origin zone to a destination zone as the unit of travel analysis. Such models 

are also often referred to as “four-step” models because they consist of four general behavioral 

steps: 

 

1. Trip Generation 

 

2. Trip Distribution 

 

3. Mode Split 

 

4. Trip Assignment 

 

Modern variations on this framework may include network pre- or post-processing steps, detailed 

time-of-day analysis, a land use model prior to trip generation, incremental demand model 

formulations, and/or feedback of congested network costs from traffic assignment to earlier steps. 

The Cube Voyager Demonstration Model and Land Use-Transport Interaction Model included in the 

Cubetown demonstration system are both examples of trip-based travel demand forecasting models 

implemented using Cube Voyager. 

 

While the trip-based approach is still widely used as of the date of this document, several planning 

agencies implement models based upon alternative frameworks, with particular focus on “tour-

based” models. These models have in common a shift away from the trip to the tour as the unit of 

travel analysis. A tour, also known as a “trip chain”, consists of a sequence of trips made by a 

traveler, starting and returning at the same location (start/return at home-location, start/return at 

work-location), with stops at various intervening zones. For example, a home-based work “tour” 

might include stops at a daycare facility on the way to and from work, as well as work-based sub-

tours to perform various errands during the day.  

 

In addition, tour-based models are typically also simulation-based, meaning that instead of 

forecasting the aggregate number of trips between zones belonging to various categories, with 

increasing refinement in trip classification through the model chain, they consider each decision-

maker (e.g. a household, a worker, or a student) in turn and apply an integrated hierarchy of choice 

models to assess the probability of a specific pattern of behavior for that individual. Monte Carlo 

methods, using random draws from the computed probability distribution, are used to assign a likely 

tour pattern to each traveler. 

 

Because travel patterns depend upon activity participation, some models that forecast tours are 

referred to as “activity-based” models. These are an extension to independent tour-based models, 

incorporating: 

• The interactions/constraints at person and household level, 

• The spatial and temporal dimension of activities.   

 

While a variety of tour-based and activity-based models have been studied in the research literature 

and applied in practice, the framework used for the Cube Voyager Activity-Based Model is loosely 
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based upon the work of John Bowman and Mark Bradley in California1. The choices considered by 

this model include: 

 

 
 

These integrated choices are modeled within a single MATRIX step, called the activity and travel 

simulator. In addition, the model system includes the following supporting processes: 

 

• A population synthesizer, which creates a sample of individuals drawn from a table of survey 

records in such a manner as to match aggregate zonal characteristics, 

 

• A network analysis process, which provides zone-to-zone travel costs by mode and time of 

day used in the activity and travel simulator, 

 

• A travel aggregator, which converts the tour-based records produced by the activity and 

travel simulator into square origin- destination format vehicle-trip matrices, and 

 

• A traffic assignment process, which performs multi-path assignment of highway and public 

transport trips by time of day and evaluates congestion. 

 

The Cube Voyager Activity Based Model example shown in the Cubetown Demonstration system 

performs each of these steps in sequence and then writes the output network to a personal 

geodatabase for GIS analysis and mapping.  

 

In the example, the congested costs produced by Highway Traffic Assignment are fed back into the 

network analysis step so that the activity and travel simulator can be run iteratively. In practice, it is 

recommended that also the Public Transport Assignment steps are included in the loop accordingly. 

 

Note that the Number of Iterations within the Loop Control is set to 1, therefore no iterations are 

undertaken in the original example. 

 

  

                                                
1 See Bowman, John and Mark Bradley. “Disaggregate treatment of purpose, time of day, and location in an 
activity-based regional travel demand forecasting model.” Proceedings of the 2005 European Transport 
Conference, October 2005, Strasbourg, France. 
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8.2 To open and examine the Activity-Based 

Model 

▪ To open and examine the activity-based model. 

1 If necessary, open the Discover Cube catalog. 

Refer to “To open the Discover Cube catalog and model” on page 13 – Cube opens 

the Discover Cube catalog in Scenario Manager. The catalog shows the scenarios, 

data, and applications used with the Cubetown demonstration models. 

2 Under Applications in Scenario Manager, double-click Cube Voyager Activity-Based 

Model to open the activity-based model example application. 

 
Cube opens the Activity-Based Model in Application Manager (AM). 

 

 
Figure 69 ABM in Cube Voyager – Application Manager 

The yellow and blue large boxes represent steps in the model outside and inside the 

feedback loop respectively, the light blue boxes show inputs to each step, and the 

green boxes show the outputs. Lines represent the links between outputs from one 

step and inputs to the next step. You can see the input and output data for the activity 

travel simulator, as well as the other supporting processes. 
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Initial HW and PT Costs 
The first step of the application is named “Initial HW and PT Costs”. This step is outside the feedback-

loop and calculates the initial skim matrices both for the HW network and the PT network. 

 

  
Figure 70 AM showing the content of the First Step of the ABM Model (Initial HW and PT Costs) 

Population Synthesizer 
The second step, outside of the feedback loop, of the application is called “Population Synthesizer”. 

This step creates a sample of individuals drawn from a table of survey records in such a manner to 

match aggregate zonal characteristics. 

 

 
Figure 71 AM showing the content of the Second Step of the ABM Model (Population Synthesizer) 

Note: Cluster intrastep could be implemented in Matrix #3 to have a reduction in runtime. 
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1. Sample data Cross-Classification 

 

The first Matrix program “Make Household table” uses household and person records from a Survey 

(PUMS = Public Use Micro Sample data) 5% microdata. A cross-classification of the HH 

characteristics is obtained using the HH size (1, 2, 3, 4, 5+) and the HH Income (0-15K, 15-30K, 30-

50K, 50-75K, >75K), obtaining 25 HH TYPEs as below: 

 
TYPE (cross-classification) Income categories 

0-15k 15-30k 30-50k 50-75k >75k 

Size Categories 1 2 3 4 5 

size 1 1 1 2 3 4 5 

size 2 2 6 7 8 9 10 

size 3 3 11 12 13 14 15 

size 4 4 16 17 18 19 20 

size 5+ 5 21 22 23 24 25 

Table 1  Table with cross-classification codes for Size and Income categories 

The reason why Size and Income has been used for the classification is that data is available at 

zonal level within these categories, nevertheless, it is possible to expand to other dimensions if data 

available. 

 

The outputs from this first step are two tables. The first table consists in the Household list from the 

sample with the associated TYPE (1 record = 1 Household): 

 

 
Figure 72 Table with list of HH and associated TYPE 

The second output table is the aggregation of the number of Households (not persons) from the 

survey, within the 25 TYPEs listed above: 

 

 
Figure 73 Table with Total HH by category from the survey  

2. Iterative Proportional Fitting to match the zonal control totals 

 

The second Matrix program “IPF by zone” uses Iterative Proportional Fitting to match the zonal 

control totals, using the proportions for the size categories and income categories. This provides a 

table with the number of HH in every TYPE for every zone, matching the control totals, as below: 
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Figure 74 Table with Total HH by category and zone from IPF 

3. Draw random population from sample 

 

The third Matrix program “Draw random person records (Monte Carlo)” draws households randomly 

from the Survey Micro-Data to match marginal distribution in each TAZ creating the synthetic 

population. The process can be summarized with the following loop: 

• Define the probability from the sample of picking each TYPE category household, this is 

given by  

 
prob = 1/ n_of_HH_within_TYPE 

 

Where: 

n_of_HH_within_TYPE = number of HH in the sample within that TYPE category. In this 

way, the sum of these probabilities for all the HH within that TYPE is 1 (100%). 

• Perform a loop over all households in that zone for that TYPE category 

 
LOOP  x=1,di.3.total 

 

Where:  

di.3.total = total number of HH within the zone and that TYPE, value expanded to 

match control totals (through IPF).  

• From the household sample, randomly choose a household ID that meets the probability. 

This is achieved by looping through the HH IDs that are matching the TYPE in the sample, 

and calculating the cumulative probability 

 
cprob = cprob + prob 

 

until cprob > rand(), where rand() = random number in the range [0; 1) from a uniform 

distribution.   

• Pick that household from the sample data with all the associated characteristics, by using 

a DBISeek function through the HH ID. 

• Write the records for each person belonging to that household in that zone. 

 

The output from this third program is the Synthetic Population table, with one record = one person 

in each zone, with the micro-data from the survey, as below: 
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Figure 75 Synthetic Population Table with 1 record = 1 person 

The values of the fields are the following: 

• HHLDID = ID of the Household 

• PERSID = ID of the person in the household (progressive counter) 

• HHSIZE = size of the Household (1=1 person, 2=2 persons, 3=3 persons, etc.) 

• GENDER = 1=male, 2=female 

• AGE = age of the person 

• EMPLOY = three classes of employment defined as: 1=full-time employed, 2=part-time 

employed, 4=other (unemployed, infant, student, retired) 

• HRZONE = zone 

• PUMSID = ID from PUMS microdata 

 

Finally, other three Matrix programs perform/provide some checks of the generated synthetic 

population in terms of control totals. 

 

Accessibility 
The first sub-group to be inside of the feedback loop is called “Accessibility”, fifth step in the overall 

flow-chart. The content of this sub-group is just one Matrix program calculating Access Measures. 

 

  
Figure 76 AM showing the content of the Accessibility step of the ABM Model 

In the model an aggregate Logsum is used, with a simplified approach, to obtain a table of Access 

Measures for every zone, with the following attributes: 
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• ZONE – Zone number 

 

• AMWACC1 – AM Peak Accessibility Logsum measure for Work Trip Purpose / OUTBOUND 

DIRECTION (travelling away from zone) 

• MDWACC1 – Mid-Day Accessibility Logsum measure for Work Trip Purpose / OUTBOUND 

DIRECTION (travelling away from zone) 

• PMWACC1 – PM Peak Accessibility Logsum measure for Work Trip Purpose / OUTBOUND 

DIRECTION (travelling away from zone) 

• OPWACC1 – Off-Peak Accessibility Logsum measure for Work Trip Purpose / OUTBOUND 

DIRECTION (travelling away from zone) 

 

• AMWACC2 – AM Peak Accessibility Logsum measure for Work Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

• MDWACC2 – Mid-Day Accessibility Logsum measure for Work Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

• PMWACC2 – PM Peak Accessibility Logsum measure for Work Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

• OPWACC2 – Off-Peak Accessibility Logsum measure for Work Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

 

• AMSACC1 – AM Peak Accessibility Logsum measure for School Trip Purpose / 

OUTBOUND DIRECTION (travelling away from zone) 

• MDSACC1 – Mid-Day Accessibility Logsum measure for School Trip Purpose / 

OUTBOUND DIRECTION (travelling away from zone) 

• PMSACC1 – PM Peak Accessibility Logsum measure for School Trip Purpose / 

OUTBOUND DIRECTION (travelling away from zone) 

• OPSACC1 – Off-Peak Accessibility Logsum measure for School Trip Purpose / 

OUTBOUND DIRECTION (travelling away from zone) 

 

• AMSACC2 – AM Peak Accessibility Logsum measure for School Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

• MDSACC2 – Mid-Day Accessibility Logsum measure for School Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

• PMSACC2 – PM Peak Accessibility Logsum measure for School Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

• OPSACC2 – Off-Peak Accessibility Logsum measure for School Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

 

• AMOACC1 – AM Peak Accessibility Logsum measure for Other Trip Purpose / OUTBOUND 

DIRECTION (travelling away from zone) 

• MDOACC1 – Mid-Day Accessibility Logsum measure for Other Trip Purpose / OUTBOUND 

DIRECTION (travelling away from zone) 

• PMOACC1 – PM Peak Accessibility Logsum measure for Other Trip Purpose / OUTBOUND 

DIRECTION (travelling away from zone) 

• OPOACC1 – Off-Peak Accessibility Logsum measure for Other Trip Purpose / OUTBOUND 

DIRECTION (travelling away from zone) 

 

• AMOACC2 – AM Peak Accessibility Logsum measure for Other Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 
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• MDOACC2 – Mid-Day Accessibility Logsum measure for Other Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

• PMOACC2 – PM Peak Accessibility Logsum measure for Other Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

• OPOACC2 – Off-Peak Accessibility Logsum measure for Other Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) 

 

• AMWACC1T – AM Peak Accessibility Logsum measure for Work Trip Purpose / 

OUTBOUND DIRECTION (travelling away from zone) – considering HOV and Transit only 

(NO SOV) 

• PMWACC2T – PM Peak Accessibility Logsum measure for Work Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) – considering HOV 

and Transit only (NO SOV) 

• MDOACC1T – Mid-Day Accessibility Logsum measure for Other Trip Purpose / 

OUTBOUND DIRECTION (travelling away from zone) – considering HOV and Transit only 

(NO SOV) 

• OPOACC2T – Off-Peak Accessibility Logsum measure for Other Trip Purpose / INBOUND 

DIRECTION (returning to zone - using TRANSPOSED skim matrices) – considering HOV 

and Transit only (NO SOV) 

 

Activity and Travel Simulator 
The second step inside the loop is called the “Activity Travel Simulator” (sub-group number 6). This 

sub-group processes: 

• The skim matrices for HW and PT, 

• The input zonal data, 

• The access measures calculated in the previous step, 

• The synthetic population obtained in step 2… 

…and predicts the outcome tours/trips for every person in the household. 

 

 
Figure 77 AM showing the content of the Activity and Travel Simulator step of the ABM Model 

Two Matrix programs are part of this group. The first Matrix program is simply aggregating the skim 

matrices for Highway and Public Transport into two Matrices: HW LOS and PT LOS. The reason 
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why this is done in this step is that this is necessary to use AUTOMDARRAY within the second 

Matrix program, with a reduction in runtime in comparison of using MATVAL. 

 

Note: Cluster intrastep could be implemented in Matrix #2 to have a further reduction in runtime. 

 

The second Matrix program is undertaking the following seven main sub-models/steps.  

 

1. Defining "Employment Group" from the Synthetic Population Table 

 

A preliminary step is adding the Employment group to the Synthetic Population database table with 

the following criteria for each person (personcnt). 

 
employtab[personcnt]=di.1.employ  

 

Where:  

di.1.employ = “employ” field within the Synthetic Population table, with the values 1=full-time 

employed, 2=part-time employed, 4=other (unemployed, infants, students, retired).  

Refining this definition based on age ranges for each person, defining STUDENTS (scholars) as 

group 3: 

 
if (di.1.age = 5-15) employtab[personcnt]=3                      

if (di.1.age = 16-17 && employtab[personcnt]> 2) employtab[personcnt]=3   

 

Obtaining the following employment groups employtab[personcnt]=: 

• 1=full-time employed 

• 2=part-time employed  

• 3=students 

• 4=other (unemployed, infants, retired) 

 

And defining a parttime variable with 1, 0 values: 
 

if (di.1.employ = 2) parttime=1  

 

2. Auto Ownership Model – Identifies the number of autos in each household 

 

The first actual sub-model is the Auto Ownership Model. This step processes the Synthetic 

Population database table and the Accessibility tables: 

• synthetic.dbf: di.1.hhldid, di.1.persid, di.1.hhsize, di.1.income, di.1.gender, di.1.age, 

di.1.employ, di.1.hrzone, di.1.pumsid, di.1.employgrp 

• accessibility.dbf: zi.2.zone, zi.2.amwacc1, zi.2.mdwacc1, ...  

 

For every Household calculates the following variables that are used in the Car Ownership model. 

 

3 variables storing the number of adults, workers and students in the HH: 

 

loop  per=1, personcnt ; Loop for every person in the household in respective zone 

        if (agetab[per] >= 16)    adults=adults+1 

        if (employtab[per] = 1,2) workers=workers+1 

        if (employtab[per] = 3)   students=students+1 

endloop  



Discover Cube Tutorial  116 
 

Therefore, adults = number of adults in the HH (age >=16), workers = number of workers in the HH 

(employment groups 1 and 2), students = number of students in the HH (employment group 3). 

 

Three categories for “adults”: 

 

if (adults = 2) adults2=1 ; --> 2 adults in the HH 

if (adults = 3) adults3=1 ; --> 3 adults in the HH 

if (adults > 3) adultsm3=adults-3 ; number of adults over the 3 adults in the HH 

   

Two variables defining “single” HHs and  “no-kids” HHs: 

 
if (hhsize=1)   single=1 

if (adults = hhsize) nokids=1 

     

Four categories for “income”: 

 
if (income < 25)       inccat1=1 

if (25 <= income < 45) inccat2=1 

if (45 <= income < 75) inccat3=1 

if (income >= 75)      inccat4=1 

 

These variables, together with the values of accessibility are then used to calculate the utilities for 

having 0, 1, 2, 3+ cars: 

 
Number of 
Cars in HH 

Utility formulation 

0 carownutil[1]= exp(0.5) 

1 

carownutil[2]= exp( 0.9 + 0.6*adults2 + 0.0*adults3 + 0.0*adultsm3 + 0.3*workers + 0.025*income -  

                        0.1*workers*(zi.2.amwacc1t[hrzone]-zi.2.amwacc1[hrzone]) -    

                        0.1*workers*(zi.2.pmwacc2t[hrzone]-zi.2.pmwacc2[hrzone]) - 

                        0.05*adults*(zi.2.mdoacc1t[hrzone]-zi.2.mdoacc1[hrzone]) - 

                        0.05*adults*(zi.2.opoacc2t[hrzone]-zi.2.opoacc2[hrzone])) 

2 

carownutil[3]= exp( -0.5 + 1.9*adults2 + 1.9*adults3 + 0.7*adultsm3 + 0.6*workers + 0.035*income  - 

                        0.2*workers*(zi.2.amwacc1t[hrzone]-zi.2.amwacc1[hrzone]) - 

                        0.2*workers*(zi.2.pmwacc2t[hrzone]-zi.2.pmwacc2[hrzone]) - 

                        0.10*adults*(zi.2.mdoacc1t[hrzone]-zi.2.mdoacc1[hrzone]) - 

                        0.10*adults*(zi.2.opoacc2t[hrzone]-zi.2.opoacc2[hrzone])) 

3+ 

carownutil[4]= exp( -1.3 + 0.8*adults2 + 1.9*adults3 + 1.0*adultsm3 + 1.0*workers + 0.040*income  - 

                        0.3*workers*(zi.2.amwacc1t[hrzone]-zi.2.amwacc1[hrzone]) - 

                        0.3*workers*(zi.2.pmwacc2t[hrzone]-zi.2.pmwacc2[hrzone]) - 

                        0.15*adults*(zi.2.mdoacc1t[hrzone]-zi.2.mdoacc1[hrzone]) - 

                        0.15*adults*(zi.2.opoacc2t[hrzone]-zi.2.opoacc2[hrzone])) 

Table 2  Utility formulations for 0, 1, 2, 3+ cars in the HH 

A Monte-Carlo simulation based on these utility levels is providing the number of cars in the HH: 

cars = 0 to 3. A further assumption is that if we obtain 3 cars and the number of adults in the HH is 

> 3, then it is assumed that every adult has a car, with a cap of 6 cars per HH: 

 

if (cars = 3 && adults > cars) cars=max(adults, 6) 

 

Therefore, cars = 0 to 6 for each Household. 

 

Three further variables are obtained from the Car Ownership sub-model as: 

if (cars = 0) nocars=1 ; no cars 

if (cars > 0 && cars<adults) carsltad=1 ; cars less than adults 

if (cars > 0 && cars<workers) carsltwk=1 ; cars less than workers 
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3. Daily Activity Pattern Choice  – For each person, identifies the activity pattern type  

 

With the Daily Activity Pattern Choice sub-model the Matrix program starts a loop over each person 

in the Household. 

 

This sub-model is based on three separate sub-models depending on the primary purpose of the 

pattern: 

• Adult Worker Model (primary = work) - employtab[per]= 1-2 

• Student Model (primary = education) - employtab[per]= 3 

• Other Adult Model (primary = other) - employtab[per]= 4 

 

The Activity Pattern is composed by a set of tours in one day. The separate components of the 

utilities (simple work tour utility, work tour with intermediate stop, etc.) defining the Activity Patterns 

utilities are calculated for the three models based on the value of employtab[per]. These 

components of the utility are then summed up to define the total utility for the entire Activity Pattern, 

defining 49 types of Activity Day-Patterns (type ID 1 to 51, as shown in Table 3):  

• 1 for “no travel” 

• 24 for Work (considering subtours for pattern=16-27) 

• 12 for education 

• 12 for other 

 

The utilities are calculated as functions of car-ownership variables from the previous sub-model, 

access measures and household characteristics (parttime, income level, no-kids). 
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Act. P. ID Primary tour Secondary tour 

1 no travel   

Adult Worker Model – primary purpose = 1 

4 simple work tour   

5 simple work tour + one secondary tour with a work tour   

6 simple work tour + two secondary tours with a work tour   

7 simple work tour + work tour with intermediate stop before   

8 simple work tour + work tour with intermediate stop before             one secondary tour with a work tour 

9 simple work tour + work tour with intermediate stop before             two secondary tours with a work tour 

10 simple work tour + work tour with intermediate stop after   

11 simple work tour + work tour with intermediate stop after              one secondary tour with a work tour 

12 simple work tour + work tour with intermediate stop after              two secondary tours with a work tour 

13 simple work tour + work tour with intermediate stops b&a   

14 simple work tour + work tour with intermediate stops b&a one secondary tour with a work tour 

15 simple work tour + work tour with intermediate stops b&a two secondary tours with a work tour 

16 simple work tour + subtour in worktour with no stops   

17 simple work tour + subtour in worktour with no stops                   one secondary tour with a work tour  

18 simple work tour + subtour in worktour with no stops                   two secondary tours with a work tour 

19 simple work tour + subtour in work tour with stop before   

20 simple work tour + subtour in work tour with stop before               one secondary tour with a work tour  

21 simple work tour + subtour in work tour with stop before               two secondary tours with a work tour 

22 simple work tour + subtour in work tour with stop after   

23 simple work tour + subtour in work tour with stop after                one secondary tour with a work tour  

24 simple work tour + subtour in work tour with stop after                two secondary tours with a work tour 

25 simple work tour + subtour in work tour with stop b&a   

26 simple work tour + subtour in work tour with stop b&a one secondary tour with a work tour  

27 simple work tour + subtour in work tour with stop b&a two secondary tours with a work tour 

Student Model – primary purpose = 2 

28 simple education tour   

29 simple education tour + one secondary tour with an education tour   

30 simple education tour + two secondary tours with an education tour   

31 simple education tour + educ tour with intermediate stop before   

32 simple education tour + educ tour with intermediate stop before            one secondary tour with an education tour 

33 simple education tour + educ tour with intermediate stop before            two secondary tours with an education tour 

34 simple education tour + educ tour with intermediate stop after      

35 simple education tour + educ tour with intermediate stop after             one secondary tour with an education tour 

36 simple education tour + educ tour with intermediate stop after             two secondary tours with an education tour 

37 simple education tour + educ tour with intermediate stops before and after    

38 simple education tour + educ tour with intermediate stops b&a one secondary tour with an education tour plus stops b&a     

39 simple education tour + educ tour with intermediate stops b&a two secondary tours with an education tour plus stops b&a    

Other Adult Model  – primary purpose = 3 

40 simple other tour   

41 simple other tour + one secondary tour with an other tour   

42 simple other tour + two secondary tours with an other tour   

43 simple other tour + other tour with intermediate stop before   

44 simple other tour + other tour with intermediate stop before            one secondary tour with an other tour 

45 simple other tour + other tour with intermediate stop before            two secondary tours with an other tour 

46 simple other tour + other tour with intermediate stop after      

47 simple other tour + other tour with intermediate stop after             one secondary tour with an other tour 

48 simple other tour + other tour with intermediate stop after             two secondary tours with an other tour 

49 simple other tour + other tour with intermediate stops b&a    

50 simple other tour + other tour with intermediate stops b&a one secondary tour with an other tour plus stops b&a  

51 simple other tour + other tour with intermediate stops b&a two secondary tours with an other tour plus stops b&a 

Table 3  Activity Pattern Types (1-51) 

The Activity Pattern is then defined for each person in the HH through Monte-Carlo simulation 

separately for the three employment groups, based on the conditional probabilities of each Activity 

Pattern (AP probability * probability of the primary purpose * probability of travelling): 

 

Therefore, pattern = 1 to 51 for each person in each Household. 

 

4. Number of stops and type of tours – For each person and each tour in the pattern, define the 

tour purpose and the number of stops (outbound and inbound). 

 

The sub-model defines the details of the Activity Pattern in terms of Tours for each person, based 

on his/her pattern from the previous sub-model. This is done by filling the values of three arrays: 
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• tpurp[tour] = array containing the primary-tour/sub-tour/secondary-tour purpose (0=no-

travel, 1=work, 2=education, 3=other, 4=work-based sub-tour purpose) 

• stopsout[tour] = array identifying the number of stops before to reach the primary-

tour/sub-tour/secondary-tour destination from the origin (0=no-stops, 1=1 stop, 2= 2 stops, 

3=3 stops, 4=4+ stops) 

• stopsret[tour] = array identifying if the number of stops after reaching the primary-

tour/sub-tour/secondary-tour destination going back to the origin (0=no-stops, 1=1 stop, 2= 

2 stops, 3=3 stops, 4=4+ stops) 

 

Three variables are also used within the process: 

• numtours = number of tours in the pattern 

• subtours = variable identifying the number of subtours within the primary tour 

• sectours = variable identifying if the number of secondary tours 

 

The definition of these arrays and variable is progressive with the steps explained below. 

 

4.1. Primary Tour – firstly the model defines the characteristics of the primary tour 

• numtours = 1 

• tpurp[1] = primary tour purpose. 0=no-travel for pattern=1, 1=work for pattern=4-27, 

2=education for pattern=28-39, 3=other for pattern=40-51 

• stopsout[1] = identifying if the primary tour has or not stops before reaching the primary 

destination from the origin (0 if no stops, 1 if stops). stopsout[1]=1 for pattern=7-9,13-15,19-

21,25-27 / 31-33,37-39 / 43-45,49-51 

• stopsret[1] = identifying if the primary tour has or not stops after reaching the primary 

destination going back to the origin (0 if no stops, 1 if stops). stopsret[1]=1 for pattern=10-

15,22-27 / 34-39 / 46-51 

• subtours = identifying if the primary tour has or not subtours (0 if no subtours, 1 if subtours). 

subtours=1 for pattern=16-27 

• sectours = identifying if there are secondary tours (0 if no secondary tours, 1 if 1 secondary 

tour, 2 if 2+ or more secondary tours). sectours=1 for patterns=5,8,11,14,17,20,23,26 / 

29,32,25,38 / 41,44,47,50, sectours=2 for patterns=6,9,12,15,18,21,24,27 / 30,33,36,39 / 

42,45,48,51 

 

4.2. Subtours – as second step the model define the number of subtours within the primary tour if 

subtours=1 from 4.1 

• subtours = 1 to 4 (where 4 = 4+) – the number of subtours within the primary tour is obtain 

through a Monte-Carlo simulation based on the probabilities for the 1-4+ subtours for 

patterns=16-27 

• ( numtours = 1 + subtours = 1 (only primary), 2 to 5 (if including subtours) ) 

• tpurp[tour] = 4 = work-based sub-tour purpose 

 

4.3. Secondary Tours – the third step define the secondary tours if sectours=1-2 from 4.1 

• sectours = 1 to 4 (where 4 = 4+)  

o if sectours=1 from 4.1, we only have 1 secondary tour, for 

patterns=5,8,11,14,17,20,23,26 / 29,32,25,38 / 41,44,47,50 

o if sectours=2 (2+) instead, the number of secondary tours (sectours) from 2 to 4 (4+) 

is obtained through a Monte-Carlo simulation based on the probabilities for the 2-4+ 

secondary tours for patterns=6,9,12,15,18,21,24,27 / 30,33,36,39 / 42,45,48,51 
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• ( numtours = 1 + subtours + sectours = 1 (only primary), 2 to 9 (if including 

subtours/sectours) ) 

• tpurp[tour] = sectour purpose = 3 (other) 

 

4.4. Number of Stops – the fourth step defines the number of outer stops (before to reach the 

destination) and return stops (after reaching the destination) for each primary tour, subtour and 

secondary tour 

• trtype = 1 (if no stop), 2 (if stop before), 3 (if stop after), 4 (both stops before and after) is 

a variable extracted, for subtours and secondary tours, using a Monte-Carlo simulation based 

on probabilities of the 4 types depending on the presence of stops in the primary tour, 

tpurp[tour] and presence of subtours. 

Note that the presence of stops before/after/both for the primary tour is given by the definition 

of the patterns (see 4.1 above). 

stopsout[tour] = 1 to 4 (4+) is extracted for primary tours, subtours and secondary tours 

using a Monte-Carlo simulation based on the probabilities of having 1-4+ stops depending 

on tpurp[tour], if there are stops in the return trip (after), if the tour is primary tour, subtour or 

secondary  

• stopsret[tour] = 1 to 4 (4+) is extracted for primary tours, subtours and secondary tours 

using a Monte-Carlo simulation based on the probabilities of having 1-4+ stops depending 

on tpurp[tour], if there are stops in the outbound trip (before), if the tour is primary tour, 

subtour or secondary 

 

5. Time of Day (activity scheduling) – For each person and each tour in the pattern, identifies the 

start and return time of day 

 

This sub-model defines the start (from origin) and return (from destination) time. This is done by 

filling the values of two arrays: 

• startperiod[tour] = array containing the start time period when the tour is starting from 

the origin for the primary tour, subtours and secondary tours (1 to 4) 

• returnperiod[tour] = array containing the return time period when the tour is starting 

from the destination (return) for the primary tour, subtours and secondary tours (1 to 4) 

 

Table 4 shows the 13 time of days (tod) that are used in the model to define startperiod[tour] 

and returnperiod[tour]. They are defined as the combination of the 4 time period (within 1 day) 

used in the model: 

• AM peak  (AM)  = 1 

• Midday  (MD)  = 2 

• PM peak  (PM)  = 3 

• Off-peak  (OP) = 4 

 
tod Start period Return period Start period descr Return period descr 

1 1 1 START in AM RETURN in AM 
2 1 2 START in AM RETURN in MD 

3 1 3 START in AM RETURN in PM 

4 1 4 START in AM RETURN in OP 

5 2 2 START in MD RETURN in MD 

6 2 3 START in MD RETURN in PM 

7 2 4 START in MD RETURN in OP 

8 3 3 START in PM RETURN in PM 

9 3 4 START in PM RETURN in OP 



Discover Cube Tutorial  121 
 

tod Start period Return period Start period descr Return period descr 

10 4 1 START in OP RETURN in AM 

11 4 2 START in OP RETURN in MD 

12 4 3 START in OP RETURN in PM 

13 4 4 START in OP RETURN in OP 

Table 4  Time of day periods considered in the model 

Note that we are considering “1 day” for the activities scheduling, therefore: 

• tod=1-4 → if the tour starts in AM, the return can be in all the 4 periods (AM, MD, PM, OP) 

• tod=5-7 → if the tour starts in MD, the return cannot be in AM, therefore only in the remaining 

3 periods (MD, PM, OP) 

• tod=8-9 → if the tour starts in PM, the return cannot be in AM and MD, therefore only in the 

remaining 2 periods (PM, OP) 

• tod=10-13 → if the tour starts in OP, the return can be in all the 4 periods (AM, MD, PM, OP)  

 

The time of day utilities for the 13 tod periods are calculated in the sub-model with a different 

formulation depending on the value of tpurp[tour] as below: 

• if (tpurp[tour] = 1) → work tour time of day utilities, functions of access measures 

and parttime 1-0 variable 

• if (tpurp[tour] = 2) → school tour time of day utilities, functions of access measures 

• if (tpurp[tour] = 3 & tour = 1) → other primary tour time of day utilities, functions 

of access measures 

• if (tpurp[tour] = 3 & tour > 1) → secondary (other) tour time of day utilities, 

defined using the sectodlookup lookup function based on primtod = variable storing the tod 

(1-13) for the primary tour as lookup value (secondary tours tod probabilities depends on 

primary tour tod) 

• if (tpurp[tour] = 4 & tour > 1) → work-based sub-tour time of day utilities, 

defined using the wbstodlookup lookup function based on primtod = variable storing the tod 

(1-13) for the primary tour as lookup value (sub-tours tod probabilities depends on primary 

tour tod) 

 

These utility levels are stored in an array with 13 elements: todutil[#]. 

 

Monte-Carlo simulation is then extracting the value of tod (1-13) depending on probabilities, and 

defining start period and return period (Table 4): 

• startperiod[tour] = 1 to 4 

• returnperiod[tour] = 1 to 4 

 

6. Joint mode / Destination Choice – For each person and each tour in the pattern, estimates the 

destination and the mode 

 

First, the sub-model defines the origin of the trip. Two types of origin are considered in the model: 

• org = hrzone, the zone that we are processing, where the person (and therefore the HH) 

resides (home-based) for primary and secondary tours 

• org = tdest[1], the origin is the destination of the primary tour if we are considering a 

work-based sub-tour (tpurp[tour]=4) 

 

The origin of each tour is stored in the array torig[tour]=org. 

 

Then the sub-model calculates the utilities for the 4 separate modes: 
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• mode=1 → Single Occupancy Vehicle (SOV) 

• mode=2 → High Occupancy Vehicle (HOV) 

• mode=3 → TRANSIT 

• mode=4 → WALK 

 

Firstly, defining the coefficients used in the utilities formulation: 

• costcoef = coefficient that multiplies monetary units of cost (tolls, fares, VOC, parking cost 

in CBD). The value of this coefficient depends on the income level (4 income categories → 

4 costcoef values) 

• the other coefficients, multiplying the other components of cost in defining the utility level, 

depends on the tour purpose (tpurp[tour]=1-4), and they are: 

o ivtcoef = in-vehicle coefficient (for SOV, HOV, transit) 

o ovtcoef = out-vehicle coefficient (for walk, transit wait time, transit transfer time) 

o hovcocc = HOV car occupancy 

 

Then, looping through every destination zone (loop dst=1,zones), and calculating the utility level 

for every destination zone, for each mode, based on these coefficients and: 

• the cost values from the input skim matrices for HW and PT 

• the definition of the parking cost for the CBD only 

• “other” components of cost (hovother, trnother, wlkother) based on car-ownership, 

income level and HH size (single) 

 

The utility levels are stored in four arrays with “zones” elements (sovutil[dst], 

hovutil[dst], trnutil[dst], walkutil[dst]). With total utility (sum of exponentials) 

stored in the array: 

  
msumutil[dst]=sovutil[dst]+hovutil[dst]+trnutil[dst]+walkutil[dst] 

 

At this point, the sub-model defines first the destination, then the mode. 

 

6.1. Destination – the sub-model generates the destinations for each primary-tour/sub-

tour/secondary-tour, for each person, through a Monte-Carlo simulation based on zonal utilities, 

calculated through the composite utility of the different modes for each destination (logsum). These 

zonal utilities have a different expression depending on the tour purpose (tpurp[tour]) and are 

stored in an array called zoneutil[dst]: 

• Work (tpurp[tour]=1)  

zoneutil[dst]=zi.1.total_emp[dst]*exp(1.50*ln(msumutil[dst])) 

• School (tpurp[tour]=2) 

zoneutil[dst]=(zi.1.enrol_elem[dst]+zi.1.enrol_hs[dst])*exp(1.50*ln

(msumutil[dst])) 

• Other and work-sub-tours (tpurp[tour]=3-4)  

zoneutil[dst]=(zi.1.retail[dst]+0.5*zi.1.service[dst])*exp(1.50*ln(

msumutil[dst])) 

 

The array storing the destination for each tour is tdest[tour]=1 to zones. 

 

6.2. Mode – the sub-model defines the mode used by each person for each primary-tour/sub-

tour/secondary-tour, to reach the destination previously defined in 6.1, through a Monte-Carlo 

simulation based on sovutil[dst], hovutil[dst], trnutil[dst], walkutil[dst]. 
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The array storing the mode for each tour is tmode[tour]=1 to 4 (SOV, HOV, Transit, Walk). 

 

Note: this could be improved by generally excluding the car-availability for work-based sub-tours 

when the primary-tour to work is made by mode=(2=HOV), 3=Transit, 4=Walk. 

 

7. Intermediate Stop Choice Model – For each person and each tour in the pattern, identifies stops 

and isolate the single trips associated to each tour. 

 

A loop is performed within this sub-model (loop thalf=1,2) where thalf represents the first or 

second half of the tour (primary-tour/sub-tour/secondary-tour), therefore the outbound or inbound 

trip respectively: 

• if (thalf=1) → org=torig[tour], dst=tdest[tour] 

• if (thalf=2) → org=tdest[tour], dst=torig[tour] 

 

Within each half of the tour the number of stops was generated (see step 4.4. above) and was stored 

in the stopsout[tour] and stopsret[tour] respectively, and it is stored in the variable 

nstops at this stage for each half of the tour. 

 

Similarly, tod stores at this stage the startperiod[tour] for the first half of the tour and 

returnperiod[tour] for the second half.  

 

A sub-loop is then undertaken, looping over all the stops within the half-tour loop 

tripn=1,nstops+1. This loop is trip segment by trip segment: 

• from the first trip segment (tripn=1), where the origin is org 

• through each stop node, where the location of these intermediate stop nodes is what is 

defined within this sub-model 

• till the last trip segment (tripn=nstops+1), where the destination is dst  

 

A further sub-loop (loop jj=1,ZONES) over every zone representing a possible stop location is 

used to: 

• Calculate a value of utility, named impedance in the model (imped) but with negative values 

for costs, from the input skim matrices for the mode specifically used in the tour and for the 

specific time period of the tour (tod).  

• The total value of impedance is calculated as the sum of the impedance from the origin to 

the stop plus the impedance from the stop to the destination. Where origin and destination 

are the updated origin and destination depending on the tripn (org, dst, or intermediate 

stops). 

• Then, each zone total utility is calculated as: 
zoneutil[jj]=(zi.1.retail[jj]+0.5*zi.1.service[jj])*exp(imped) 

• The overall sum of the utilities is stored in the variable sumzoneutil 

 

A Monte-Carlo simulation is then used to randomly extract the zone corresponding to the stop 

location, based on the utility calculated in such way. This is stored in the variable nextdst. 

 

Before to write the final outputs, the program corrects the mode used in the trip in the following way: 

• If the mode used for the tour is CAR (1=SOV, 2=HOV) or WALK (4), then the mode for the 

trip to the stop is the mode of the tour. 
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• If the mode used for the tour is TRANSIT (3), then the availability of transit services (through 

in-vehicle time skim) is checked for this sub-trip and mode is set to WALK (4) in case of no 

availability of transit services. This is done till the destination is reached.  

Note: this could be improved by checking a distance threshold for walking. 

 

8. Final Outputs  

 

The final outputs from this program are: 

• ABM_TRIPS.DBF 

The main output (used in the next steps of the ABM model) is the trip record table (sub-trip 

by sub-trip), including: 

o I = sub-trip origin zone 

o J = sub-trip destination zone  

o MODE = 1=SOV, 2=HOV, 3=TRANSIT, 4=WALK 

o PERIOD = 1=AM, 2=MD, 3=PM, 4=OP 

o ORGPURP = 1=Work, 2=School, 3=Other, 4=Sub-tour-other (origin – back to work), 

5=intermediate stop, 6=Home 

o DSTPURP = 1=Work, 2=School, 3=Other, 4=Sub-tour-other (destination – from 

work), 5=intermediate stop, 6=Home 

o ADIST = Trip Distance 

o TTIME = Trip Travel Time  

o TCOST = Trip Cost information 

Each record = each trip belonging to each tour for each person in each household  

 

 
Figure 78 ABM_TRIPS.DBF 

• ABM_TOURS.DBF 

This output provides the characteristics of each tour. 

Each record = each tour for each person in each household 

 

 
Figure 79 ABM_TOURS.DBF 

• ABM_PATTERNS.DBF 

This output provides the number of tours, purpose of the primary tour and presence of 

secondary-tours for each person. 

Each record = each person in each household 
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Figure 80 ABM_PATTERNS.DBF 

 

Travel Aggregator 
The third step inside the loop is called the “Travel Aggregator” (sub-group number 7). This sub-group 

performs two tasks: 

• Matrix #1 and #2 process the Trip Records table ABM_TRIPS.DBF from the Activity and 

Travel Simulator step and provides the matrices for the 4 modes for the 4 time periods. 

• Matrix #3 and #4 process the Trip Records table ABM_TRIPS.DBF and the Synthetic 

Population table SYNTHETIC.DBF and create the matrices selecting the trips of persons with 

home location in a certain zone (selected using the catalog key {SelectZone}). 

 

 
Figure 81 AM showing the content of the Travel Aggregator step of the ABM Model 

 

Assignment 
This step is performing a simplified Highway assignment for the 4 time periods. In this simplified 

demonstration model, only the HW assignment is performed, but the PT path-building process 

should be performed as well, considering congested travel time over the road network when 

necessary. 

 

The updated HW skim matrices are also calculated within this sub-group, to be fed-back into the 

loop.  
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GIS Outputs 
The last step is outside of the loop and it is saving in an output geodatabase the output networks 

from the HW assignments for the four periods, restoring geometry from the input network.  

 

 

8.3 To run the Activity-Based Model 

Now that we have analyzed the ABM Demonstration Application process, we can run it and have a 

look at the results. 

▪ To run the entire ABM 

1 Under Scenarios in Scenario Manger, double-click on Base. 

 
Cube opens the Scenario Editing window for the Base scenario. Just as in a standard 

trip-based model, you can analyze different highway networks, public transit services, 

and socio-economic assumptions. In addition, the example application shows how 

distributed processing can be used to speed up model runs on computers with more 

than one processor. You can also perform a select zone analysis. Unlike traditional 

select zone analysis, this will consider all trips made by residents of a given zone, as 

explained above. 

 

 
Figure 82 Scenario Panel (or Scenario Editing Window) for the Base Scenario for the ABM Application 

 

2 Run the model 

▪ Click Save, then Run in the Scenario Editing window. 

The Task Monitor window opens, showing the progress of the run. When 

complete, a Task Run Result dialog box opens. 

▪ Click OK. 

▪ Click Close to hide the Scenario Editing window and return to the Application 

Manager view. 
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8.4 To Analyze the Outputs of the ABM 

First, we should have a look at the tours and trips that have been created, to have a better 

understanding of the different types of tours that we have generated. 

▪ To open the ABM_TRIPS.DBF and the input network 

1 Double click on the “Trip Records” output table produced by the Activity Travel 

Simulator process (step 6). 

 
2 Double click on the Line File 1 (BasePT) network within the PT program #1 inside of 

the Initial HW and PT Costs > PT Skims sub-application (step 2 > 3 > 1). This will 

open the combined PT and HW network. 

 
Four examples of types of tours that we can encounter are provided in the next pages. 
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Example 1. Primary Tour with 1 stop during the return trip 

 

 
TORIG TDEST TPURP TMODE STOPS1 STOPS2 THALF TRIPN I J ORGPURP DSTPURP PERIOD MODE TTIME 

1 6 3 3 0 1 1 1 1 6 6 3 2 3 36.58 

1 6 3 3 0 1 2 1 6 4 3 5 3 3 18.10 

1 6 3 3 0 1 2 2 4 1 5 6 3 3 37.63 

Table 5  Primary Tour with 1 stop during the return trip 

 

 

A graphical representation of this tour is given in Figure 83. 

 

• The primary purpose for this tour is PRIMARY = 3 (other) 

• The primary tour start in PERIOD = 2 (Midday) and return in PERIOD = 3 (PM Peak) 

• The used mode is MODE = 3 (Transit) for all the sub-trips 

 

 
Figure 83 Primary Tour with 1 stop during the return trip – graphic representation 
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Example 2. Primary tour with no-stops + Work-Based Sub-Tour 

 

 
TORIG TDEST TPURP TMODE STOPS1 STOPS2 THALF TRIPN I J ORGPURP DSTPURP PERIOD MODE TTIME 

1 6 1 1 0 0 1 1 1 6 6 1 1 1 9.80 

1 6 1 1 0 0 2 1 6 1 1 6 3 1 10.04 

Work-Based Sub-Tour 

6 4 4 1 0 0 1 1 6 4 1 4 2 1 2.12 

6 4 4 1 0 0 2 1 4 6 4 1 2 1 2.31 

Table 6  Primary Tour with no-stops + Sub-tour 

 

 

A graphical representation of this tour is given in Figure 84. 

 

• The primary purpose for this tour is PRIMARY = 1 (work) 

• The primary tour start in PERIOD = 1 (AM Peak) and return in PERIOD = 3 (PM Peak) 

• A work-based-sub-tour is undertaken in PERIOD = 2 (Midday) 

• The used mode is MODE = 1 (SOV – Car) for all the sub-trips 

 

 
Figure 84 Primary Tour with no-stops + Sub-tour – graphic representation 
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Example 3. Primary Tour with 1 stop during the outbound trip + 1 Secondary Tour with 1 stop 

during the return trip 

 

 
TORIG TDEST TPURP TMODE STOPS1 STOPS2 THALF TRIPN I J ORGPURP DSTPURP PERIOD MODE TTIME 

1 5 3 2 1 0 1 1 1 6 6 5 2 2 8.72 

1 5 3 2 1 0 1 2 6 5 5 3 2 2 5.40 

1 5 3 2 1 0 2 1 5 1 3 6 2 2 13.30 

Secondary Tour 

1 6 3 3 0 1 1 1 1 6 6 3 3 3 34.63 

1 6 3 3 0 1 2 1 6 7 3 5 4 3 11.74 

1 6 3 3 0 1 2 2 7 1 5 6 4 3 46.00 

Table 7  Primary Tour with 1 outbound stop + 1 Secondary Tour with 1 inbound stop  

 

A graphical representation of this tour is given in Figure 85. 

 

• The primary purpose for this tour is PRIMARY = 3 (other) 

• The primary tour start in PERIOD = 2 (Midday) and return in PERIOD = 2 (Midday)  

• The used mode is MODE = 2 (HOV – Car) for the primary tour 

• A secondary tour is undertaken in PERIOD = 3 (PM Peak) and return in PERIOD = 4 (Off-

Peak)  

• The used mode is MODE = 3 (Transit) for the secondary tour 

 

 
Figure 85 Primary Tour with 1 outbound stop + 1 Secondary Tour with 1 inbound stop  
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We are also interested in analyzing the assigned volumes along the network links. 

▪ To visualize the volume bandwidths 

1 Double-click on the AM GDB Loads output network produced by the GIS Outputs 

process (step 10). 

 

 
 

Cube opens the AM_Loads network in the GIS Window. 

2 Click on the Analysis > Multi-Bandwidth  button in the toolbar. 

3 Set up a Highway Layer Link Band Width display for the V3_1 output variable, which 

is the select zone volume set, as shown below. Click OK when done. 

4  

 
 

Cube displays the select zone volume bandwidth in the GIS Window. 
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Figure 86 Select Zone Volumes bandwidths for the AM output loaded network – ABM  

 

The width of each link in this map is proportional to the number of trips on that link 

made by residents of the zone selected for analysis (Zone 1 by default). Note that this 

includes trips made by selected zone residents that do not have the selected zone as 

either the origin or the destination (i.e. non-home based trips). Therefore, this analysis 

will capture more information about the travel patterns of selected zone residents than 

would a typical select zone analysis. 
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9 Exploring Cube Avenue 

Cube Avenue brings the Mesoscopic approach and Dynamic Traffic Assignment Equilibrium to 

Cube, loading and tracking the movement of vehicles throughout the network. 

 

Avenue is an additional module completely integrated within the Cube Voyager modelling steps and 

using standard Cube Voyager commands and scripts. 

 

9.1 Understanding the model 

▪ To open and examine the Cube Avenue Demonstration Model. 

1 If necessary, open the Discover Cube catalog. 

Refer to “To open the Discover Cube catalog and model” on page 13. 

2 Under Applications in Scenario Manager, double-click Cube Avenue Demonstration 

Model to open the example application. 

 
Cube opens the Avenue model in Application Manager (AM). 
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Figure 87 Cube Avenue Demonstration Model – Application Manager 

The components of the example applications are the following: 

• A Pilot program #1 is copying an empty geodatabase in the scenario directory 

({SCENARIO_DIR}) to store outputs. 

• Network program #2 prepare the input network for the Avenue assignment by computing 

the value of STORAGE based on a distance threshold ({DistThresh}). The reasoning behind 

this pre-processing step is that in DTA, short links usually results in queues upstream. 

Therefore, STORAGE values of short links should be revised, typically applying a fictitious 

high STORAGE value. The length threshold depends on the specific model and study area. 

• The Matrix Pre-Processing sub-application contains two Matrix programs: 

o Matrix program #1 applies a user define multiplicative factor to the entire hourly 

matrix from the Cube Voyager Demonstration Model, and set intrazonal trips to 0 

Matrix program #2 create the time-segment matrix for LOV and HOV car trips based 

on a set of multiplicative factors giving the hourly distribution, and applies bucket-

rounding to obtain integer numbers for trips. The demand matrix for Avenue has: 

▪ 6 Time Segments 

▪ Each Time Segment has 10 minutes duration 

• The Avenue program #4 performs an Hybrid Assignment, combining a static assignment 

for trucks and a dynamic assignment for cars, with the following characteristics: 

o Static Traffic Assignment for the Trucks vehicle category – 1 hour trip matrix 

o Dynamic Traffic Assignment for the Cars vehicle category with:  

▪ 2 User Classes – LOV and HOV 

▪ 60 minutes simulation period 

▪ 1 Warm-Up (10 minutes) + 6 Time-Segments (10 minutes) 

▪ The same Generalized Cost formulation is used for LOV and HOV in the 

example 

▪ Packet size = 1 
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• Network program #5 is used to post-process the loaded Avenue network, calculating values 

of Occupancy ratios by time segment, as VITS#_1 / STORAGE 

Where: 

VITS#_1 are the number of vehicles in transit on a link at the end of time segment # (flowing 

or queuing) 

• Matrix program #6 post-process the Avenue Packet-Log File, obtaining a table with Origin-

Destination, departure time and travel time in minutes for all the generated packets, together 

with the information if the packet reached the destination (ARRIVED=1/0). 

 

9.2 Running an existing scenario 

▪ To run the Base scenario 

1 In Scenario Manager under Scenarios, double-click Base. 

Cube opens the scenario window for the Base scenario. You use this window to run 

and manage the scenario. 

 

 
Figure 88 Scenario Panel (or Scenario Window) for the Base Scenario – Cube Avenue 

From the scenario window, click Run. The Task Monitor window opens and shows 

the progress of the model run. When the run is complete, the Task Run Result dialog 

box opens. 

 

2 Click OK. 

 

The dialog box and the Task Monitor window closes. Next, we will examine the 

results. 

 

3 In Application Manager, double click on the output Network File from Network 

program #5 (Results_AVE.mdb\AvenueNET_LoadedOcc). 

 

The GIS window opens, showing the Avenue loaded network. 

 

4 Add volume bandwidths to visualize bandwidths animation with colors based on 

queue length. 

▪ Select the AvenueNET_LoadedOcc layer in the table of contents. 

▪  From the Analysis ribbon tab, choose Multi-Bandwidth. 

▪ The Highway Layer Link Band Width Settings dialog box opens. 
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Figure 89 Highway Layer Link Band Width Settings dialog box 

 

 
Figure 90 Highway Layer Link Band Width Settings dialog box 

 

▪ Verify that the settings show the volume of traffic entering the link during the 

time segment VS{Key1}_1 ({Key} = time segment). 
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Property Value 
  

Set 1: Volume and queues 

Attributes VS{Key1}_1 

Select Key Key1 

Value / pixel 100 

Selection Criteria FUNC_CLASS=1-9 
  

 

NOTE: You can right-click in the Selection Criteria edit box to select 

FUNC_CLASS from a list of available variables. 

▪ Click OK. 

 

The GIS window updates to show the bandwidth display. 

 

 
Figure 91 Multi Bandwiths for the Avenue Assignment for the Base Scenario 

5 To animate the bandwidths over the time segments 

▪ Select 'Bandwidth / Chart…'   

▪ Select 'Display Time' and define settingsas in Figure 92. 

▪ Start and observe the animation. To increase the time segment manually 

Pause the animation and use Ctrl+ and Ctrl- to increase/decrease key value. 

▪ Turn the Multi-Bandwith off by expanding the Multi-Bandwith… menu and 

select Bandwith Off. 

  



Discover Cube Tutorial  138 
 

 
Figure 92 Multi Bandwiths Animations settings for the Avenue Assignment for the Base Scenario 

 

6 To visualize the packet-log animation 

▪ Select Avenue Packets…   

▪ Browse to the Scenario Directory (Base) and select PACKETS.LOG or copy-

paste the path: C:\Cubetown\Base\PACKETS.LOG. 

▪ Click OK to the message stating the number of packets that have been loaded 

for the simulation period. 

▪ Define settings accordingly to Figure 93 or test different settings. 

▪ Click Start to run the animation and zoom to an area of interest. 

 

 
Figure 93 Packet Animation Options 
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Figure 94 Packet Log Animations for the Avenue Assignment for the Base Scenario 

 

7 Close the map and the scenario window. 

8 Changing values of the catalog key {MATFACTOR} (car matrix global factor) to values 

higher than 1 can be explored for visualization of a more congested network. 
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10 Exploring Cube Analyst & Analyst 

Drive 

Cube Analyst and Cube Analyst Drive are two separate modules in the Cube suite. They are the 

programs performing estimation of OD Trip Matrices. 

 

Cube Analyst is the original matrix estimation program capable of a wide variety of static type 

estimation problems. The methodology implemented in Analyst is based on the Maximum Likelihood 

Method. 

 

Cube Analyst Drive is the latest matrix estimation program designed for both static and dynamic 

estimation. The methodology implemented in Analyst Drive is based on GLS minimization with Data 

Assimilation Techniques. 

 

At the time of writing the current stage of development allows the tasks in the below table to be 

performed using the two programs. 

 

 
Table 8  Tasks that can be accomplished with Analyst Vs Analyst Drive  

The user should always use Cube Analyst Drive when possible, being Analyst Drive the program 

currently supported and developed by Citilabs. 

 

The Cubetown demonstration model provides with examples of implementation for both Analyst and 

Analyst Drive. The user should consider that the implementation of the Assignment-Matrix Estimation 
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loop is flexible and depends on the specific modelling approach, therefore the provided examples 

should be considered as one possible type of implementation for demonstration purposes. 

 

10.1 Cube Analyst Demonstration Model 

▪ To open and examine the Cube Analyst Demonstration Model. 

1 If necessary, open the Discover Cube catalog. 

Refer to “To open the Discover Cube catalog and model” on page 13. 

2 Under Applications in Scenario Manager, double-click Cube Analyst Demonstration 

Model to open the example application. 

 
Cube opens the Analyst model in Application Manager (AM). 

 

 
Figure 95 Cube Analyst Demonstration Model – Application Manager 

A Loop is implemented between Highway Assignment and Analyst Matrix Estimation 

to use an updated Intercept File (ICP) due to the previous-loop estimated matrix. 

Updated Trip Ends are used as additional constraints to the ME step. 

 

A final Highway assignment is implemented outside the Loop, to assign the final 

Matrix. A final Network step is calculating the final Goodness-of-Fit statistics.  

 

Make sure to select the “Base” scenario before to run the application. 
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10.2 Cube Analyst Drive Demonstration Model 

▪ To open and examine the Cube Analyst Drive Demonstration Model. 

1 If necessary, open the Discover Cube catalog. 

Refer to “To open the Discover Cube catalog and model” on page 13. 

2 Under Applications in Scenario Manager, double-click Cube Analyst Drive 

Demonstration Model to open the example application. 

 
Cube opens the Analyst Drive model in Application Manager (AM). 

 

 
Figure 96 Cube Analyst Drive Demonstration Model – Application Manager 

The two large yellow boxes contains the two demonstrative applications that are 

implemented for Analyst Drive Matrix Estimation: 

▪ Static OD Estimation 

▪ Dynamic OD Estimation  

 

Make sure to select the “Base” scenario before to run the application. 

 

Static OD Estimation 
The Static OD Estimation sub-application provides an example of Matrix Estimation procedure within 

a Loop between Highway Static Assignment and Analyst Drive Matrix Estimation for multiple User 

Classes. 
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Figure 97 Cube Analyst Drive Demonstration Model for Static Estimation – Application Manager 

 

The components of the example application are the following: 

• Matrix program #1 produces the initial Prior matrix for the Matrix Estimation loop, by 

eliminating intrazonals  

• Highway program #3 produces ICP and Screenline Files for three separate User Classes 

(LOV, HOV and Trucks) 

• Matrix program #4 prepares the Matrix File for the Matrix Estimation, with the format below. 

 
And provide the Trip Ends to constrain the Matrix Estimation for the three User Classes. Note 

that alternatively the Trip Ends that could be used could also be the Trip Ends from the initial 

Prior matrix for every loop  

• Network programs #6, #7 and #8 extract observed and simulated link flows and calculate 

Goodness-of-Fit summary statistics for the three User Classes loop-by-loop 

• Analyst Drive program #9 perform the simultaneous Matrix Estimation for the three User 

Classes and provide with the estimated matrix 

• Matrix programs #10, #11, #12, #13 compare prior-post estimation matrices and calculate an 

updated matrix for the next loop as below: 

 
MW[1] = mi.1.1 ;LOV PRIOR 

MW[2] = mi.1.3 ;HOV PRIOR 

MW[3] = mi.1.5 ;TRUCKS PRIOR 

 

MW[11] = MW[1] + (1/@AMLoop_1@) * mi.2.1 

MW[12] = MW[2] + (1/@AMLoop_1@) * mi.3.1 

MW[13] = MW[3] + (1/@AMLoop_1@) * mi.4.1 

 

Where 

mi.2.1, mi.3.1, mi.4.1 are the post-prior differences matrices  

@AMLoop_1@ is the loop iteration 
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• Highway program #14, outside the Loop, performs the Static Assignment with the Matrix 

estimated during the last loop 

• Network programs #15, #16, #17 calculate final Goodness-of-Fit statistics 

• Matrix programs #18, #19, #20 compare the final estimated matrices with the initial matrices 

obtaining difference matrices, Trip Length Distribution and Trip Ends comparison. 

 

Make sure to select the “Base” scenario before to run the application. 

 

Dynamic OD Estimation 
The Dynamic OD Estimation sub-application provides an example of Matrix Estimation procedure 

within a Loop between Avenue Dynamic Assignment and Analyst Drive Matrix Estimation for multiple 

User Classes. 

 

 
Figure 98 Cube Analyst Drive Demonstration Model for Dynamic Estimation – Application Manager 

 

The components of the example application are the following: 

• Three preliminary steps (Network #1, Matrix #2 and #3) are outside the Loop and they 

prepare the network, screenline files and initial Prior matrices for Dynamic Assignment and 

the Matrix Estimation  

• Avenue program #5 performs the Dynamic Assignment generating the Packet Log File used 

in the Matrix Estimation Analyst Drive step, using in input the updated matrices loop-by-loop. 

The performed assignment is a so called “hybrid” assignment, assigning the Truck volumes 

with a Static Assignment, and the other two User Classes (LOV and HOV) as Dynamic Load. 

The User should note that the Truck matrix is considered as a fixed input in this example 

application 

• Network programs #6, #7, #9, #10 extract observed and simulated link flows and calculate 

Goodness-of-Fit summary statistics for the two User Classes (LOV and HOV) loop-by-loop 
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• Matrix program #11 is used to generate the updated Control Data File for Analyst Drive, by 

updating the XLOBND and the XUPBND based on the current PRMSE, to reduce variations 

to the prior matrices loop-by-loop. Please refer to the Cube Analyst Drive Reference Guide 

for more details on these keywords. 

• Analyst Drive program #12 performs the Dynamic Matrix Estimation for LOV and HOV 

simultaneously. 

• Matrix program #13 undertakes “Bucket Rounding” of the estimated matrices for the next 

Avenue-Analyst Drive loop 

 

• Avenue program #14 performs the Dynamic Assignment for the final estimated Matrices  

• Network programs #15, #16,#17, #18 extract observed and simulated link flows and calculate 

final Goodness-of-Fit summary statistics for the two User Classes (LOV and HOV)  

 

Make sure to select the “Base” scenario before to run the application. 
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11 Learning More 

Citilabs is committed to helping you get the most out of Cube. This chapter discusses resources 

available to learn more about Cube: 

 

• User support 

 

• User forum 

 

• Training 

 

• Consulting and assistance 
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11.1 User support 

Citilabs provides free user support for all new product or upgrade purchases. You can purchase 

additional user support on an annual basis through a software maintenance contract. A current 

maintenance contract provides you with user support and free software updates. 

 

To access Citilabs user support, please visit http://www.citilabs.com/support/#support-contact or 

write an e-mail to support@citilabs.com. 

 

  

http://www.citilabs.com/support/#support-contact
mailto:support@citilabs.com
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11.2 User forum 

Citilabs has an online user group. Through the user group, you can exchange information and ideas 

with others who use Citilabs software, drawing on the large wealth of knowledge available from the 

Citilabs user community. We encourage you to join at: http://community.citilabs.com  

 

Within the community you can also fine a special section containing How To posts with several 

relevant examples and useful applications. 

 

  

http://community.citilabs.com/


Discover Cube Tutorial  149 
 

11.3 Training 

Citilabs holds training sessions throughout the year in major cities around the world. You may also 

access additional tutorials and webinars at the Cube Learning Center: 

http://www.citilabs.com/support/learning-center. 

 

For a listing of currently scheduled courses and locations, visit http://www.citilabs.com/events. 

 

If you have specific training needs not met by our regular course offerings, please contact us. We 

would be happy to work with you to develop training appropriate for your specific needs. 

 

Online training courses are also available within our Citilabs U web-page: 

http://citilabs.teachable.com upon subscription. 

 

  

http://www.citilabs.com/support/learning-center
http://www.citilabs.com/events
http://citilabs.teachable.com/
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11.4 Consulting and assistance 

Citilabs is a full-service multimodal transportation software and planning firm. We offer a range of 

consulting services, such as the development of specialized planning software applications and 

utilities, and the research and implementation of advanced planning methods. 

 

To find out more about the range of consulting services offered by Citilabs, please visit: 

http://www.citilabs.com/services. 

 

  

http://www.citilabs.com/services
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12 Acquiring Cube 

This chapter discusses available licensing options for Cube and provides a list of representatives 

you can contact for more information about Cube 6 or to initiate a purchase: 

 

• Licensing options 

 

• Contacts 
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12.1 Licensing options 

Citilabs licensing system evolved over the years, from a dongle-based system (Cube 6.1.1. and 

earlier releases) to a dongle-free system based on a 16-digit activation code (Cube 6.4 and later 

releases). 

 

Two types of licenses are provided with the un-dongled system: Node locked and Floating: 

• Node Locked licenses are stand-alone licenses and are tied to one individual PC.  

• Floating licenses are server based licenses which allow multiple users to check out the 

license (based on the availability) by connecting to the server.  

 

Discounts are available for multiple seats. Citilabs also offers free licenses for educational use. 

 

For more information on licensing, please contact licensing@citilabs.com. 

 

 

 

 

  

mailto:licensing@citilabs.com
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12.2 Contacts 

Citilabs sells Cube directly in most parts of the world. In some countries, Citilabs uses distributors. 

 

To obtain a quote, or for further information about Cube, contact the appropriate representative for 

your part of the world at: http://www.citilabs.com/contact  

 

 

  

http://www.citilabs.com/contact
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13 Index 

 

A 

Activity-Based Models (ABM), 105 

Activity and Travel Simulator, 114 

Auto Ownership Model, 115 

Daily Activity Pattern Choice, 117 

Intermediate Stop Choice Model, 123 

Joint mode / Destination Choice, 121 

Number of stops and type of tours, 118 

Population Synthesizer, 109 

Time of Day, 120 

Travel Aggregator, 125 

Types of tours, 127 

Analyst, 140, 141 

Analyst Drive, 139, 140 

Application Manager, 7, 32 

Program boxes, 32 

Sub-Groups, 32 

Applications, 30 

Applier mode, 9 

ArcGIS map document, 17 

ArcGIS Online layer, 19 

Avenue, 139 

Avenue Packets, 138 

B 

Bandwidths, 36, 48, 135 

Basemaps from arcgisonline, 20 

C 

Catalogs, 30 

Cluster 

Cluster intrastep, 109, 115 

Compare two maps, 45 

Consulting, 150 

Contacts, 153 

Cube Cargo, 82, 83 

Cube GIS, 17 

Cube Land, 92 

Aggregate, 92 

Endogenous, 96 

Equilibrium, 92 

Impacts of this roadway project, 102 

Input Files, 95 

LUTI, 92, 93 

Output Files, 96 

Cube Windows, 8 

Cubetown, 34 

D 

Demographic data, 50 

Desire lines, 54 

Developer mode, 9 

Dynamic Traffic Assignment, 133 

F 

Feature Explorer, 39 

forum, 148 

H 

Highway networks, 38 

New road link, 41 

Set Current Feature Attributes as Template, 43 

vertex editing, 38 

Hybrid Assignment, 134 

L 

Licensing, 152 

M 

Maps, 17 

Mesoscopic, 133 

O 

Open Cube, 14 

P 

Packet-Log File, 135 

Public transit, 47 

headway, 47 

R 

Reports, 57 

Run, 34, 135 

S 

Scenario Manager, 30 

Scenarios, 30 

Storage, 134 

support, 147 
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T 

Thematic map, 51 

Training, 149 

W 

Window Management, 8 
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